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Preface

Safety information

Safety alert words

MSDSs

SOLID™ 3 System Instrument Operation Guide

\Q Note: For general safety information, see this Preface and Appendix J, “Safety”
on page 157. For important safety information related to the use of the Covaris™
S2 system, please refer to the user documentation of the product. When a hazard
symbol and hazard type appear by a chemical name or instrument hazard, see the
“Safety” Appendix for the complete alert on the chemical or instrument.

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

ﬁ CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
results in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety symbols” on page 158).

The MSDSs for any chemicals supplied by Applied Biosystems or Ambion are
available to you free 24 hours a day. For instructions on obtaining MSDSs, see
“MSDSs” on page 167.

IMPORTANT! For the MSDSs of chemicals not distributed by
Applied Biosystems or Ambion contact the chemical manufacturer.

Vii



Preface
Safety information

Safety labels on  The following CAUTION, WARNING, and DANGER statements may be displayed on
instruments  Applied Biosystems instruments in combination with the safety symbols described in
the preceding section.

Hazard

symbol English Francais

Safety Data Sheets (MSDSs) before handling. les fiches techniques de slreté de matériels avant
toute manipulation de produits.

CAUTION! Hazardous waste. Refer to MSDS(s) and | ATTENTION! Déchets dangereux. Lire les fiches
local regulations for handling and disposal. techniques de sireté de matériels et la régulation
locale associées a la manipulation et I’élimination
des déchets.

j CAUTION! Hazardous chemicals. Read the Material = ATTENTION! Produits chimiques dangereux. Lire

CAUTION! Potential slipping hazard. ATTENTION! Risque potentiel d'avoir un sol
& glissant.
j WARNING! Hot lamp. AVERTISSEMENT! Lampe brilante.
WARNING! Hot. Do not remove lamp until 15 min AVERTISSEMENT! Lampe br(lante, apres avoir
after disconnecting supply. déconnecté le cable d’alimentation de I'appareil,

attendre environ 15 minutes avant d’effectuer un
remplacement de la lampe.

WARNING! Hot. Replace lamp with an AVERTISSEMENT! Composants brdlants.
Applied Biosystems lamp. Remplacer la lampe par une lampe
Applied Biosystems.
CAUTION! Hot surface. ATTENTION! Surface brilante.
CAUTION! Replace only with Applied Biosystems ATTENTION! La Lampe devra étre remplacée par
recommended light source (PN 4388441). un model recommandé par Applied Biosystems, Réf
de la lampe: 4388441.
f DANGER! High voltage. DANGER! Haute tension.
WARNING! To reduce the chance of electrical AVERTISSEMENT! Pour éviter les risques
shock, do not remove covers that require tool d’électrocution, ne pas retirer les capots dont
access. No user-serviceable parts are inside. Refer I’ouverture nécessite I'utilisation d’outils.
servicing to Applied Biosystems qualified service L'instrument ne contient aucune piéce réparable par
personnel. I'utilisateur. Toute intervention doit étre effectuée par

le personnel de service qualifié venant de chez
Applied Biosystems.

CAUTION! Moving parts. Crush/pinch hazard. ATTENTION! Piéces en mouvement, risque de
é pincement et/ou d’écrasement.

viii SOLID™ 3 System Instrument Operation Guide
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How to use this guide

How to use this guide

Text conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

» [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All Runs.

User attention  Two user attention words appear in Applied Biosystems user documentation. Each
words  word implies a particular level of observation or action as described below:

Ay Note: —Provides information that may be of interest or help but is not critical to
the use of the product.

IMPORTANT! — Provides information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
» Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
* Obtain information about customer training.

* Download software updates and patches.

SOLID™ 3 System Instrument Operation Guide
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SOLiD™ 3 System run types

Chapter 1

Introduction

On the Applied Biosystems SOLiD™ 3 System, you can perform three types of runs:
workflow analysis (WFA), sequencing (standard), and multiplex sequencing (see

Table 1).
Table 1 Run types on the SOLID™3 system
WEFA Sequencing MuItipIe_x
(standard) sequencing
Purpose Assess various Generate Generate multiplex

preparations of
templated beads
to determine
potential quality
of sequence data

Evaluate fraction
of P2-positive
beads

Use as a tool to

sequencing data for

fragment or mate-
paired libraries

sequencing data for
fragment libraries

determine
deposition
density for
sequencing
slides
Run summary P1 and P2 bead Up to 10 ligation Up to 10 ligation
counting cycles for each of 5 | cycles for each of
Single ligation primers resulting in 5 primers resulting
cycle 50 bases per tag¥ in 50 bases per tag
Report and
generation 1 ligation cycle for
each of 5 primers
resulting in 5 bases
per barcode tag
Estimated run time§ | ~4 to 5 hours e ~3to 4 days for e ~6to 7 days for
25 bp 50 bp
e ~B6to 7 days for e ~1 day for
50 bp barcode
Deposition chamber | 4-well e 1-well e 1-well
o 4-well o 4-well
e 8-well e 8-well
Number of beads 15 million beads per | ¢ 310 million e 310 million
well beads per well beads per well
(1-well) (1-well)

e 60 million beads

per well (4-well)

e 30 million beads

per well (8-well)

60 million beads
per well (4-well)

30 million beads
per well (8-well)

SOLID™ 3 System Instrument Operation Guide
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1 Chapter 1 Introduction
SOLID™ 3 System run types

T One tag for fragment libraries and 2 tags for mate-paired libraries
§ Total run time for dual slide run. Times may deviate depending on imaging time.

Use Figure 1 to choose the run type that most closely meets your sequencing needs:

Mo ultiplexing Yes

desired?

Mo Yes

qPCR to be
used?
Yes

Library titrated?

Mo

Y

rTEI'I'IplﬂtEd bead preparation slt1 Quantitative (GPCR) FTempIated bead preparation at ) FTempIated bead preparation wa
two library concentrations q optimal library concentration pocled barcoded libraries
L s L r " s
" Workflow analysis (WFA) run ) > E Sequencing run on ) 'Mtdlbiamd saquencing run an )
on S0LI0D™ 3 Analyzer S0LID™ 3 Analyzer S0LID™ 3 Analyzer
L. " L. " L. "

Figure 1 Relationship between the three types of SOLID™ runs.

Workflow analysis  You can optimize sequencing results by performing workflow analysis (WFA) runs. A
(WFA) run WFA run analyzes a quadrant of a slide that undergoes a single ligation cycle. The
quadrant contains beads deposited at a lower density than the density of beads
deposited for a sequencing run.

A WFA run determines the:

» Optimal library concentration: the library concentration for optimal preparation
of templated beads using the library. You use this library concentration for any
preparation of templated beads for that library as long as the scale of templated
bead preparation is the same.

* Bead enrichment efficiency: the proportion of beads that have been successfully
amplified using emulsion PCR (ePCR) as a fraction of the total number of beads
prepared. You use this value to more accurately deposit successfully amplified
beads for a sequencing run.

WFA runs require the same materials as those materials needed for sequencing runs. If
you perform multiple WFA runs routinely, you should order additional SOLiD"™
Instrument Buffer Kits.

To perform a WFA run, prepare slide and install reagents according to the procedure in
Chapter 2, “Prepare and install slides and reagents” on page 11, then set up and
monitor the run according to the procedure in Chapter 3, “Set Up, Control, and
Monitor the Run” on page 41.

SOLID™ 3 System Instrument Operation Guide



Chapter 1 Introduction 1
SOLiD™ 3 System run types

Sequencing run  During a SOLiD™ sequencing run, two probe sets are used to maximize the fraction of
“mappable” beads, read length, and sequencing throughput. (Mappable beads are beads
amplified with template that map to the reference genome.) This protocol must be used
for sequencing 50-bp reads of both mate-paired and fragment libraries. Compared to
terminator-based sequencing chemistry, with SOLiD sequencing, base information is
not collected; instead, five rounds of primers (Primers A, B, C, D, and E) are used to
sequence template by ligation of di-base labeled probes (see Figure 2 and Figure 4 on
page 4). For sequencing of fragment libraries, the set of primers used are specific to the

P1 Adaptor.

Bead ] P1 Adaptor | Fragment | P2 Adaptor |

\ |

0123456 7 8 91011121314 151617 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50

0000000000000000000000000000000000000000600000000000000000000000

| Frag Primer A Cycle 1 | Cycle 2 Cycle3 | Cycle 4 Cycle 5 | Cycle 6 Cycle 7| Cycle 8 Cycle 9 | Cycle 10 |
Frag Primer B Cycle 1 | Cycle 2 Cycle3 | Cycle 4 Cycle5 | Cycle 6 Cycle 7 | Cycle 8 Cycle 9 | Cycle 10 |
| Frag Primer C | Bridge Probe Cycle 1 | Cycle 2 Cycle3 | Cycle 4 Cycle5 | Cycle 6 Cycle 7 | Cycle 8 Cycle 9 |
[ Frag Primer D | Bridge Probe Cycle 1 | Cycle 2 Cycle3 | Cycle 4 Cycle5 | Cycle 6 Cycle 7 | Cycle 8 Cycle 9 | Cycle 10 |
| Frag Primer E | Bridge Probe Cycle 1 | Cycle 2 Cycle3 | Cycle 4 Cycle5 | Cycle 6 Cycle 7 | Cycle 8 Cycle 9 | Cycle 10 |

Cycle 10 |

Figure 2 SOLiD™ 3 System interrogation of nucleotide positions for a 50-bp
fragment sequencing run.

The typical workflow for a fragment sequencing run is shown below (see Figure 3).

" Load reagents and slide onto SOLID™ 3 Analyzer

Run Frag Primer A (up to 10 cycles)
Run Frag Primer B (up to 10 cycles)
Run Frag Primer C (up to 10 cycles)

Run Frag Primer D (up to 10 cycles)

Run Frag Primer E (up to 10 cycles)

y

Figure 3 Typical workflow for a fragment sequencing run.

For sequencing of mate-paired libraries, the set of primers used to sequence one of the
tags is specific to the P1 Adaptor, while the set of primers used to sequence the other
tag is specific to the Internal Adaptor (see Figure 4 on page 4).

SOLID™ 3 System Instrument Operation Guide 3
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-I Chapter 1 Introduction
SOLID™ 3 System run types

a1 2 348 67T 8 90121314 161617 70 1620 21 22 Z3 24 25 26 2T 20 28 30 37 02 03 4 35 36 37 38 30 40 41 42 41 44 49 45 47 48 49 40

J00000000000000000000000LLoLA0CLOLLOOLDALCdYORDOOdLAELADDED
TR | Gy 1 [N NORRRT] - Cyons [N TOURAT]  rons [ TORROT] Ccven 7 [ TOUBET] C v [ IGREETEY

01 F 3 45 8 T AR B0 1F13 41518 1T 181020 31 22 23 34 35 36 3T FR 2D 30 31 32 33 34 A5 38 37 35 30 40 41 42 43 44 45 46 47 48 49 50

ﬁ!ﬂ]ﬁlﬁ]ﬂ]ﬂ]ﬂ]ﬁﬂ]@t’][')tﬁ[']ﬂ]t']éﬁ')f]ﬂ]f]ﬂ]ﬂ]t']['}tﬁ[']ﬁt')ff}tﬁflﬂ]f]E'J5]E'Jf}['][']ﬁ[ﬁf]ﬁf]Gﬁﬂlébf}ﬁﬁﬁﬁéééﬂ]ﬁﬂﬂﬂb

Figure 4 SOLID™ 3 System interrogation of nucleotide positions for a 50-bp mate-
paired sequencing run.

The typical workflow of a mate-paired sequencing run is shown below (see Figure 5 on
page 5).

SOLID™ 3 System Instrument Operation Guide
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SOLiD™ 3 System run types

[ Load reagents and slide onto SOLID™ 3 Analyzer
Run MP Tag 2 Primer A (up to 10 cycles)

Q

Run MP Tag 2 Primer B {up to 10 cycles) -g

Run MP Tag 2 Primer C (up to 10 cycles) E

Run MP Tag 2 Primer D (up to 10 cycles) %

Q

Run MP Tag 2 Primer E (up to 10 cycles) 5

\ * % S

Instrument pauses

Y

Load reagents and slide onto SOLID™ 3 Analyzer

r

Run MP Tag 1 Primer A (up to 10 cycles)
Run MP Tag 1 Primer B (up to 10 cycles)
Run MP Tag 1 Primer C (up to 10 cycles)
Run MP Tag 1 Primer D (up to 10 cycles)

Run MP Tag 1 Primer E (up to 10 cycles)

Figure 5 Typical workflow of a mate-paired sequencing run.

Multiplexed ~ For sequencing of barcoded fragment libraries, the set of primers used to sequence the
sequencing  fragment is specific to the P1 Adaptor, while the set of primers used to sequence the
barcode sequence is specific to the Internal Adaptor (see Figure 6 on page 6).

SOLID™ 3 System Instrument Operation Guide 5
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[ R Cyoe 1 |
B P B Cyie 1

E;.-'ltluwc E Baprcts | t}peln|!
[TEERmes | e [ Gy |

| BCPinwE | wswebws | Cyoke 1|

o~

| I
ej F1 Adaptor | Fragmant Hn-rem P2 Adaptor
| |

d 1 2 345 6 T 8 91011121314 9515 17 18 19 20 21 37 23 24 75 25 F7 28 25 30 31 37 33 34 35 36 37 38 30 40 41 42 43 44 45 46 47 48 49 50

0{5DE]E]E]E]i]E}C}GGE}E}E}GE}&G@OGGE}GGE}GGOlfJEJEJﬂJEJEJOC]EJEJOGGOGOOE}E}GE}OD&G@GE}E}E}GMO

|!qu'r|murA | Cyoim Cyle Cyce & t:m: T Cycied
e 1 m" m - u
T Tam e | o ~ oy [T opes [LOET] et o
FragFrivarE | Rildge Fraba Cyela © Cyela 3 |0 JCyeed | Cyce5 |0 JGpERE | _ Cyck? | Gpela® | _ Cycled [0 ‘Gyoa 0]

Figure 6 SOLiID™ 3 System interrogation of nucleotide positions for a 50-bp
fragment and 5-bp barcode sequencing run.

The typical workflow of a multiplex sequencing run is shown in Figure 7 on page 7.

6 SOLID™ 3 System Instrument Operation Guide
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SOLiD™ 3 System run types

[ Load reagents and slide onto SOLID™ 3 Analyzer

Run BC Primer A {1 cycle) o
=
Run BC Primer B (1 cycle) 3
(0}
Run BC Primer C {1 cycle) -
Run BC Primer D {1 cycle) %
Q
Run BC Primer E (1 cycle) S
\ ) 2
* 5

Instrument pauses

Y

[ Load reagents and slide onto SOLID™ 3 Analyzer

Run Frag Primer A (up to 10 cycles)
Run Frag Primer B (up to 10 cycles)
Run Frag Primer C (up to 10 cycles)

Run Frag Primer D (up to 10 cycles)

Run Frag Primer E (up to 10 cycles)

Figure 7 Typical workflow of multiplex fragment sequencing run.

To perform a sequencing or multiplex sequencing run, prepare slides and install slides
and reagents according to the procedure in Chapter 2, “Prepare and install slides and
reagents” on page 11, then set up and monitor the run according to the procedure in
Chapter 3, “Set Up, Control, and Monitor the Run” on page 41.

SOLID™ 3 System Instrument Operation Guide 7
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Data analysis

Data analysis may be organized into primary, secondary, and tertiary analysis (see
Table 2).
Table 2 Types of data analysis

Type of Analysis Description

Primary Includes universal processes for data
generation, collection, and raw processing

Secondary Analyzes application-specific data at the
sequence level

Tertiary Generates biological interpretation specific to
an application

The software tools used to set and control data analysis include SOLiD"™ Instrument

Control Software (ICS), SOLiD™ Experiment Tracking System (SETS), and SOLiD
Analysis Tools (SAT) (see Table 3). The relationship between these software tools in

the SOLiD™ sequencing run workflow is shown in Figure 8 on page 9.
Table 3 SOLiID™ software tools

T™

Software Application Type Function
ICS Windows application Instrument operation
SETS Browser-based application Reports and reanalysis
SAT Linux command line tool Command line tool for

analysis

SAT automatically processes the image during the instrument run, performs data
filtering, calculates quality values, aligns to a reference genome, and generates base
calls. The result can be exported automatically to offline compute clusters for further
analysis. SETS allows you to reanalyze data and review/export results. For offline
analysis, Global SETS encompasses SETS and SAT for offline analysis and can carry
on a compute job from the auto-exported data. For detailed data analysis using SETS
and SAT, refer to the Applied Biosystems SOLiD"™ SETS Software Getting Started
Guide (PN 4389302) and the Applied Biosystems SOLiD™ Analysis Tools (SAT) User
Guide (PN 4392959), respectively.

SOLID™ 3 System Instrument Operation Guide
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Before SR o
Run 2 Primary analysis setting
Secondary analysis setting g
SETS Load reference saqueance o
Set up user email notification for instrument run -%
Set up user preferences for auto-export after primary analysis to perform =
secondary analysis offline :
=]
v g
a
Mo 9]
ics QFARD =
=
Yes
SETS EIH'FA nun report ]
P — *
Set up Create sequencing run or multiplexed seqguencing run
R |CS |Detect focus range
un Start run
e
o *
During [l-:hack email notification for any system errorfwarming ]
Run [
| -
Manitor (remote) Monitor (on-instrument)
Cycle scans - Cycle scans
SETS Heat map . Heat map
Run metrics * Runlog ICS
Exposure lime Pause/resume run
Run control
Imagingfanalysis controls
I
i T 5
Cancel analysis
Feanalyze
2 Primary analysis
SETS |- Secondary analysis
Preview run metrics
Clean up data (e.g., delete runs, delete intermediate results)
Export resulis
L "
' ¢ ™)
Matching summary report
Imaging metrics report
Heat map report
SETS |Cycle heat map report
Cycle scans
Other analysis-specifiic reports
Download important results data
L r
SAT [ﬁs—analyza or perform further secondary analysis (via the command line) _]
Corona_lite [Ferfnrm tertizry analysis (via the command line) ]

Figure 8 Relationship between software tools in SOLID™ sequencing run
workflow.
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For additional secondary and tertiary analysis tools, visit the SOLiD™ Software
Development Community website (http://solidsoftwaretools.com). One can integrate
standalone tools from the SOLiD™ Software Development Community with the SAT
pipeline to perform more automated analysis. For details, see the SOLiD™ Analysis
Tools (SAT) User Guide (PN 4392959).

10 SOLID™ 3 System Instrument Operation Guide
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2 Chapter 2 Prepare and install slides and reagents
Materials and equipment required

Materials and equipment required

See Appendix A, “Set up and perform a workflow analysis (WFA) run” on page 86 for
a list of equipment, kits, and consumables necessary to set up a workflow analysis
(WFA) run.

See Appendix A, “Set up and perform a sequencing run” on page 90 for a list of
equipment, kits, and consumables necessary to set up a sequencing run.

12 SOLID™ 3 System Instrument Operation Guide



Workflow

Deposit the beads
on the slide(s)

Install on-
instrument
reagents

Chapter 2 Prepare and install slides and reagents 2
Workflow

Deposit the beads on the slide(s)
Wash the baads

Deposit the beads

Y

Install on-instrument reagents
Prepare 1= Instrument Buffer

Prepare 1= T4 Ligase Buffer

Prepare Imaging Buffer
Prepare Cleave Sclution 2
Install reagents

Check waste level

Prime Instrument and Storage Buffers lines

. 3
( Install aﬂdn{s]tn instrument )
( Install reagent ntrz[s] on instrument )
( Set up, control, and mnnlttr the run (see Chapter 3) )

For a WFA run, the beads are quantitated using the SOLiD"™ Bead Concentration Chart
(PN 4415131), and 15 million beads are deposited in one well of a four-well SOLiD™
Deposition Chamber.

For a sequencing run, the choice of SOLiD™ Deposition Chamber depends on factors
such as the requirements of the experiment, number of libraries being assessed, the size
of the genome, and the sequencing coverage required. Three SOLiD™ Deposition
Chamber designs are available for use (see Table 4).

Table 4 Three deposition chamber designs

Deposition Chamber Number of image panels
1-Well 2357
4-Well 432 per well
8-Well 186 per well

1X Instrument Buffer is prepared from glycerol and 10X Instrument Buffer provided in
the SOLiD™ Instrument Buffer Kit. 1X Instrument Buffer may be formulated in 8-L

batches as needed or may be prepared in larger volumes and stored at 4 °C until ready
for use. T4 Ligase Buffer, Imaging Buffer, and Cleave Solution 2 are each prepared by

SOLID™ 3 System Instrument Operation Guide 13
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Chapter 2 Prepare and install slides and reagents

Tips

Install slide(s) on
the instrument

Install reagent
strip(s) on the

Tips

14

instrument

General

Covaris™ S2
System

combining the two parts provided in the SOLiD"™ Instrument Buffer Kit. The chiller
block should be cooled prior to installation of buffers. The tubing from the Instrument
and Storage Buffer bottles to the flowcell is long, and the lines must be primed before
the slides are installed in the flowcell.

The slide is removed from the Deposition Chamber and prepared for installation on the
instrument. Each flowcell can be loaded with the slide independently of each other.

The workflow analysis or sequencing reagent strips are installed on the reagent strip
chiller block. The chiller block should be cooled prior to installation of reagent strips.

Prior to deposition, slides must be stored appropriately and kept dry in a
desiccator to ensure optimal bead deposition and to minimize loss of P2-enriched
beads. Remove the slides from the desiccator only when you are ready to deposit
the beads onto the slide.

Perform all steps requiring 0.5-mL, 1.5-mL, and 2.0-mL tubes with Eppendorf
LoBind tubes.

Adjust microcentrifuge speeds and times according to the g-forces specified in the
protocols.

The procedures are optimized for the Covaris'~ S2 System. The Covaris S2
System must be specially adapted to prepare beads for the Applied Biosystems
SOLiD™ 3 System. Do not use the Covaris S1 sonicator or an unadapted Covaris
S2 System for bead preparation. For more information, contact an Applied
Biosystems SOLiD"™ System applications specialist.

Ensure that the Covaris S2 System is degassed, that no bubbles are present in the
system, and that the instrument and tube are properly aligned for appropriate
sonication of beads.

To ensure optimal sonication by the Covaris™ S2 System, use the appropriate
adaptor with the Covaris S2 System. For sample volumes < 200 pL, use a 0.5-mL
LoBind tube and 0.65-mL tube adaptor. For sample volumes between 200 uL. and
600 pL, use a 1.5-mL LoBind tube and 1.5-mL tube adaptor. For sample volumes
between 600 puL and 1.2 mL, use a 2.0-mL LoBind tube and the same adaptor as
used for the 1.5-mL tubes. Place the tube collar at the indicator line of the adaptor.
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Deposit the beads

For the following hazards, see the complete safety alert descriptions in Appendix J,
“Safety” on page 157:

/'\ WARNING! CHEMICAL HAZARD. Deposition Buffer.

Wash the beads ‘\g Note: The bead wash procedure is for one WFA or sequencing run sample.

1. Sonicate P2-enriched beads using the Covalent Declump 1 program on the
Covaris™ S2 System (for program conditions, see “Covalent Declump 17 on
page 140). Pulse-spin, but do not pellet the beads.
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2. If a WFA run has already been performed, use the results from the WFA report to
estimate the bead concentration and proceed to step 5; otherwise, use the SOLiD™
Bead Concentration Chart (PN 4415131) to estimate the bead concentration (see

Figure 9).

125K 250K 500K 750K ™ 1.5M M
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(-7 OPTIMAL RANGE —-\
1.25M

Figure 9 The SOLiID™ Bead Concentration Chart. For best results, use the Applied
Biosystems SOLID™ Bead Concentration Chart (PN 4415131), supplied separately.

3. Adjust the volume of beads so that the color of the bead solution matches a color
in the optimal range (750,000 beads/pL to 1.25 million beads/uL; see Figure 9 and
Figure 10 on page 16).

SOLID™ 3 System Instrument Operation Guide 15
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[ Match beads o color chart (750,000 to 1.25 milllon beads/jl) -]
Too light Too dark
Color of Suspension?

Place bead suspension in magnetic

rack and remove some of the Dilute with more 1% TEX Buffer
supernatant
[ Match beads to color chard (750,000 o 1.25 million beadsul) ]
Too light Too dark
Color of Suspension?
[ Quantitate beads using the NanoDrop™ ND-1000 Spectrophotometer ]

Figure 10 SOLiID™ Bead Concentration Chart workflow.

4. When the bead concentration is within the accurate range, quantitate the beads
using the NanoDrop® ND-1000 Spectrophotometer [refer to “Quantitate the beads
using the NanoDrop® ND-1000 Spectrophotometer,” in the Applied Biosystems
SOLiD™ 3 System Templated Bead Preparation Guide (PN 4407421)].

5. Transfer the appropriate number of beads (see Table 5) to a 1.5-mL LoBind tube
and store the remaining beads at 4 °C.

Table 5 Beads to use according to the type of run and deposition chamber

Type of run Deposition chamber Number‘zfell?*e ads per
WFA 4-well 15 million

Sequencing 1-Well 310 million

Sequencing 4-Well 60 million

Sequencing 8-Well 30 million

1 Note: The calculated bead concentration based on the WFA report is the most accurate (see
“Determine the bead deposition density for a sequencing run” on page 54). If WFA run results are
not available, it is recommended to target an additional 50% over the bead concentration
determined by the SOLID™ Bead Concentration Chart followed by NanoDrop® measurement.

6. Place the tube of aliquoted beads in a magnetic rack for at least 1 minute. After the
solution clears, remove and discard the supernatant.

7. Resuspend the beads in 400 uL of Deposition Buffer, vortex thoroughly, then

pulse-spin.

16 SOLID™ 3 System Instrument Operation Guide
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Deposit the beads

8. Place the tube in a magnetic rack for at least 1 minute. After the solution clears,
remove and discard the supernatant.

9. Repeat steps 7 and 8 twice.

10. Resuspend the beads in the volume of Deposition Buffer indicated on the sticker
attached to the lid of the SOLiD™ Deposition Chamber (see Table 6).

Table 6 Approximate Deposition Buffer volumes

Deposition chamber Volume per well (pL)
1-Well 550
4-Well 400
8-Well 300
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Deposit the beads 1. Thoroughly clean, rinse, and dry the SOLiD™ Deposition Chamber overnight
before deposition:

a. Clean the SOLiD Deposition Chamber using a sonicator or Extran 300
detergent (see “Clean the SOLiD™ Deposition Chamber using a sonicator”
on page 98 or “Clean the SOLiD™ Deposition Chamber using Extran 300”
on page 100).

\Q Note: Do not wash the SOLiD Deposition Chamber with ethanol
because ethanol damages the adhesive on the O-ring.

b. Blot the SOLiD Deposition Chamber dry on a lab wipe. Be particularly
careful to dry around the O-ring and to remove fluid from the fill ports.

c. Place the SOLiD Deposition Chamber in an incubator at 37 °C for at least
one hour to complete drying.

2. Insert a new slide into the SOLiD™ Slide Carrier (see Figure 11 on page 19):

@ IMPORTANT! Do not touch the slide surface.

a. Move the retainers so that the slide can fit into the SOLiD Slide Carrier. Push
down on the two spring knobs in the SOLiD Slide Carrier and slide the knobs
towards the outside edges of the carrier (see Figure 11 on page 19, Figure
11a).

b. Place the slide against the alignment nubs in the SOLiD Slide Carrier.

c. Ensure that the slide is precisely positioned in the SOLiD Slide Carrier and
then slide the retainers inward until they hold the slide in position (see
Figure 11 on page 19, Figure 11b).

\j Note: To move the retainers over the slide, do not push down the
knobs.

18 SOLID™ 3 System Instrument Operation Guide
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Crientation key

Spring retainer

Spring retainer
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Figure 11 Slide carrier (a) with spring knobs pushed out and (b) with spring knobs
pushed in.

3. Place the SOLiD Slide Carrier assembly into SOLiD Deposition Chamber base,
then place the appropriate SOLiD Deposition Chamber lid on top (see Figure 12).

\@ Note: The SOLiD Deposition Chamber top must engage with the
orientation key to fit properly. The orientation key is in the lower-left
position when the SOLiD Slide Carrier assembly is placed on the
instrument. This orientation must be maintained in order to preserve the
correct sample order when the 4-well or 8-well SOLiD Deposition
Chamber is used.

Screw tab

Figure 12 SOLID™ Deposition Chambers: 1-well, 4-Well, and 8-well.

SOLID™ 3 System Instrument Operation Guide 19
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9.

Tighten the four screw tabs on the SOLiD Deposition Chamber in a crisscross
pattern until the lid is securely attached.

Twist the tabs flat.

Sonicate the beads using the Covalent Declump 3 program on the Covaris"~ S2
System (for program conditions, see “Covalent Declump 3” on page 141).
Afterwards, pulse-spin, but do not pellet the beads.

Repeat step 6.

Use a pipettor with an appropriate tip to pipette the bead solution up and down a
few times, then withdraw the sample of templated beads from the microcentrifuge

tube.

IMPORTANT! Samples must be deposited onto the slide immediately after
sonication to minimize clumping and maximize monolayering.

Perform one of the following steps:

If the SOLID™ Deposition Chamber has... Then perform steps...

1 well 10to 12
4 or 8 wells 13to 16

10.

11.

12.

13.

14.

15.

16.

Elevate and tilt the SOLiD Deposition Chamber with the entry porthole of the well
at the lowest point.

Carefully pipette a sample of templated beads into the well through the porthole.
As the area of the well fills, lower the top of the SOLiD Deposition Chamber so
that it becomes level.

Proceed to step 15.

With the SOLiD Deposition Chamber flat, carefully pipette a sample of templated
beads into one of the 4 or 8 wells through the porthole.

Repeat steps 8 to 13 to fill each of the remaining wells with each sample of
templated beads. Note each sample's well position relative to the slide orientation.

Place 3-mm adhesive disks over all the portholes in the SOLiD Deposition
Chamber.

Incubate the SOLiD Deposition Chamber at 37 °C for 1.5 hours.
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Install on-instrument reagents

For the following hazards, see the complete safety alert descriptions in Appendix J,
“Safety” on page 157:

/'\ WARNING! CHEMICAL HAZARDS. 10X Instrument Buffer, Glycerol.

/'\ CAUTION! CHEMICAL HAZARDS. Glycerol.

‘\g Note: For information about recommended fill volumes for on-instrument
reagents, see “Recommended fill volumes for on-instrument reagents” on
page 122.

Prepare & Note: Prepare buffers just prior to use on the SOLiD™ 3 Analyzer.
1X Instrument -
Buffer
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1. Add 800 mL of 10X Instrument Buffer to an empty 8-L reagent bottle.

IMPORTANT! Rinse the 8-L Instrument Buffer bottle with deionized
water between runs to prevent microbial buildup and contamination.

pue sapi|s ||e1sul pue aiedald g Jerdeyn

2. Add 1600 mL of glycerol to the reagent bottle. Use a graduated cylinder to
measure the glycerol.

3. Add 5600 mL of double-distilled water, rinsing residual glycerol from the
graduated cylinder.

4. Using a clean magnetic stir bar, mix the solution for 10 minutes to ensure
homogeneity.

5. Remove the stir bar and install the prepared buffer on the SOLiD™ 3 Analyzer or
store at 4 °C until ready for use.

Prepare 1X T4 1. Transfer the contents of the 1X T4 Ligase Buffer Part 1 tube to the 1X T4 Ligase
Ligase Buffer Buffer Part 2 bottle.

2. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure
thorough mixing and to minimize bubbles.

Prepare Imaging 1. Transfer the contents of the Imaging Buffer Part 1 bottle to the contents of the
Buffer Imaging Buffer Part 2 bottle.

2. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure
thorough mixing and to minimize bubbles.

SOLID™ 3 System Instrument Operation Guide 21
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Prepare Cl_eave 1. Transfer the contents of the Cleave Solution 2 Part 1 bottle to the contents of the
Solution 2 Cleave Solution 2 Part 2 bottle.

2. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure
thorough mixing and to minimize bubbles.
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Install reagents 1. Double-click the SOLiD™ Instrument Control Software icon to launch the
SOLIiD Instrument Control Software, if it is not already open.

2. Under the System Status menu, select Cooling from the Chiller drop-down menu
(Figure 13).
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Figure 13 Select Cooling to cool the flowcell.

3. After the chiller temperature is < 10 °C, install the buffers on the SOLiD™ 3
Analyzer according to the following steps.

4. Install the prepared 1X Instrument Buffer and Storage Buffer into the appropriate
positions in the cabinet (see Figure 14 on page 24).
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Storage Buffer

1x Instrument Buffer
Waste

Figure 14 Positions of buffers and waste in the cabinet.

5. Install Cleave Solution 1, prepared Cleave Solution 2, and Reset Buffer in the
appropriate positions on the side of the instrument (see Figure 15).

et
Daart Sty

- mme i
] IETET

Cleave Solution 2

Reset Buffer

Cleave Solution 1

Figure 15 Positions of reagent bottles on the side of the instrument.

24 SOLID™ 3 System Instrument Operation Guide



Chapter 2 Prepare and install slides and reagents 2
Install on-instrument reagents

6. Install the prepared Imaging Buffer, prepared 1X T4 Ligase Buffer, and
Phosphatase Buffer into the appropriate positions in the chiller block (see
Figure 16).

FPhaosphatase Buffer
1X T4 Ligase Buffer

Imaging Buffer
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Figure 16 Positions of buffer bottles in the chiller block.

Check the waste & CAUTION! POTENTIAL SLIPPING HAZARD. Opening the door to the
level computer rack requires moving the side cart. To move the side cart, the
tubing must be detached from the waste container. This may cause a spill.
The spill can create a potential slipping hazard. If the waste container
contents are spilled, clean up immediately.

1. Check the level of waste in the 10-L carboy.

2. TIf the carboy is more than % full, properly dispose of the waste according to your
institution's environmental health and safety guidelines.

Prime Instrument @ IMPORTANT! The priming of the lines must be performed prior to each run

and Storage Bll_Jffer whether the Instrument and/or Storage Buffers were changed or not.
Ines

1. Under the System Status menu, click Prime (see Figure 17 on page 26).
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Figure 17 Click Prime to prime the instrument and storage buffer lines.

2. During priming, open the middle front door of the SOLiD™ 3 Analyzer to check
that the syringe is filled with buffer when the plunger is at the aspiration stage (see
Figure 18 on page 27). Confirm that the buffer lines are filled with buffer. If the
syringe is not filled with buffer even at the last stroke, click Prime again.
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Figure 18 Syringe on the SOLID™ 3 Analyzer.
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Install the slide(s) on the instrument

28

For the following hazards, see the complete safety alert descriptions in Appendix J,
“Safety” on page 157:

/'\ WARNING! CHEMICAL HAZARD. 2-Butanol, 1X Bead Wash Buffer.

Prepare the slide

(1) IMPORTANT! Before removing the slide from the SOLiD™ Deposition

Chamber, ensure that either the instrument flowcell is ready or a SOLiD™ Slide
Storage Chamber is available.

. Remove the 3-mm adhesive disks.

. Pour enough Deposition Buffer to cover the top of the SOLiD Deposition

Chamber (1.5 mL in each port for the 1-well SOLiD Deposition Chamber and
6 mL for the 4-well and 8-well SOLiD Deposition Chambers).

. Using an appropriate pipettor and pipette tip, press down the plunger button, then

place the tip into one of the portholes of the well. Slowly release the pipettor
plunger button, then aspirate the Deposition Buffer. Fresh Deposition Buffer is
drawn into the well to replace the old Deposition Buffer, and aspiration removes
unattached beads. Repeat this procedure for the other wells.

. Gently loosen the SOLiD Deposition Chamber screws. As the screws are

loosened, more fresh Deposition Buffer is drawn into the Deposition Chamber.

. Open the SOLiD Deposition Chamber lid, then carefully remove the SOLiD Slide

Carrier assembly from the Deposition Chamber.

. Immediately pour the minimum amount of Overlay Buffer needed to completely

cover the bead spots on the slide. Pouring Overlay Buffer onto the bead spots
prevents the slide from drying out during subsequent handling.

. Immediately place the SOLiD Slide Carrier assembly onto the instrument or into

the SOLiD Slide Storage Chamber.

STOPPING POINT. If you are storing the slide, place the SOLiD™ Slide Carrier assembly
into the SOLiD™ Slide Storage Chamber, then fill with 5 mL Slide Storage Buffer.
Store the slide at 4 °C until the slide is ready for use (see Figure 19 on page 29).
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Figure 19 SOLID™ Slide Storage Chamber.

Install the slide  For the following hazards, see the complete safety alert descriptions in Appendix J,
“Safety” on page 157:

/'\ WARNING! CHEMICAL HAZARD. 2-Butanol, 1X Bead Wash Buffer.
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@ IMPORTANT! Before removing a slide from a previous run, ensure that the run,
images, and data collected from the previous run are satisfactory. For more
information, refer to the Applied Biosystems SOLiD™ 3 System SETS Software
Getting Started Guide (PN 4389302).

pue sepis |[eisul pue aiedald g 481deyn

1. Check to see if a SOLiD Slide Carrier assembly from a previous run is present in
the flowcell chamber. If a SOLiD Slide Carrier assembly is present in the flowcell
chamber, proceed with steps 2 to 4. If a SOLiD Slide Carrier assembly is not
present in the flowcell chamber, skip to step 5.

2. For each flowcell to be used, click the Clear Flowcell button at the bottom of the
flowcell panel (see Figure 20 on page 30).
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Figure 20 Click Clear Flowcell to flush the contents from the flowcell.

3. After clearing each flowcell, open the appropriate flowcell chamber.

4. Remove the SOLiD Slide Carrier assembly from the previous run. If the slide will
be reused, place the SOLiD Slide Carrier assembly into a SOLiD Slide Storage
Chamber, then fill the chamber with Slide Storage Buffer. Store the SOLiD Slide
Storage Chamber at 4 °C.

WARNING! PHYSICAL INJURY HAZARD. Hot Surface. Surface of
i) flowcell may be hot. Use care when working around the flowcell to avoid
being burned.

5. Clean the flowcell block with 70% ethanol and Kimwipes® to remove residue.

6. Inspect the O-ring and reseat it if necessary (see Figure 21 on page 31; for details,
see “Install the SOLiD™ Flowcell O-Ring” on page 102). Check the O-ring for
cuts and abrasions. If any abnormalities are observed, replace it. Inspect the O-
ring grooves for debris or contamination and clean with water as needed.
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ﬂ :

Figure 21 O-ring installed on flowcell.

7. Ensure that the instrument and storage buffer lines are primed before loading a
slide, or the slide will dry out.
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8. Insert the SOLiD Slide Carrier onto the instrument. Work quickly to prevent the
slide from drying out.

a. Remove the SOLiD Slide Carrier assembly from the SOLiD Deposition
Chamber or from the SOLiD Slide Storage Chamber.
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/\ WARNING! PHYSICAL INJURY HAZARD. Hot Surface.
i) Surface of flowcell may be hot. Use care when working around the
flowcell to avoid being burned.

b. Place the SOLiD Slide Carrier assembly into the open flowcell, engaging the
alignment key on the carrier with the corresponding part on the flowcell.

c. Slide the two SOLiD Slide Carrier lock-down tabs on the flowcell inward
until they are positioned over and flush with the carrier (see Figure 22 on
page 32).

IMPORTANT! Ensure that the tabs are flush with the carrier. If
necessary, loosen the Allen screws further, then slide the tabs over the
SOLIiD Slide Carrier.

d. To properly seat the carrier on the flowcell, gradually tighten the 2 Allen
screws on both lock-down tabs in an alternating fashion to 20 inch-pounds.

e. Rotate the flowcell up and lock it into the scan position.
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Slide Carrier bek-down

Slide Carrier bok-down

Figure 22 SOLID™ Slide Carrier lockdown tabs.

9. Close the instrument doors.

10. Click the Load Flowcells button located at the bottom of the flowcell panel. Each
flowcell has its own Load Flowcells button (see Figure 23).
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Figure 23 Click Load Flowcells to load the flowcell with buffer.
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11. Click Yes to start loading the flowcell.

IMPORTANT! The flowcell should be loaded within 1 to 2 minutes of
slide installation. Slides should be installed one at a time, with flowcells
loaded before installing a second slide.

12. Check for leaks to ensure that the slide does not dry out.

13. Ifonly one flowcell will be used, ensure that unused flowcell SOLiD Slide Carrier
lock-down tabs are pushed all the way in and tightened before closing the unused
flowcell.
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Install reagent strip(s)

For the following hazards, see the complete safety alert descriptions in Appendix J,
“Safety” on page 157:

WARNING! CHEMICAL HAZARDS. Sodium Acetate Solution, Sodium
Acetate Solution, 20X SSPE Buffer.

1. Clean the needle and bottom of the needle holder with a Kimwipe® (see
Figure 24). If needed, first moisten the Kimwipe with deionized water or use a
pre-moistened alcohol pad.

Meedle holder

Meedle

Figure 24 Needle and needle holder.
2. Thaw the appropriate reagent strip(s) on ice.

3. Place the reagent strip(s) in an ABgene® 96-well square-well storage plate and
centrifuge at 160 x g for 2 minutes. For reagents needed for a WFA or sequencing
run, see Figure 25 on page 35 to Figure 29 on page 37. For information about
contents of reagent tubes, see “Reagent strip layouts” on page 124.

IMPORTANT! For barcoded fragment libraries of short insert sizes such as small
RNA samples or SAGE tags, consult your field applications specialist on the
recommended reagents for sequencing the target read on barcoded samples,
which is different from the SOLiD"™ Fragment Library Sequencing - Master Mix
50.
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SOLID™ Workflow Analysis Reagents
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Figure 26 Reagent strip block layout to sequence fragment (50 bp).
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SOLID™ Mixing Strip Tube
SOLIiD™ MP Lib Seq — Tag 1 Primer E Reagents
SOLIiD™ MP Lib Seq — Tag 1 Primer D Reagents
SOLID™ MP Lib Seq — Tag 1 Primer C Reagents

SOLiD™ MP Lib Seq — Tag 1 Primer B Reagents

OLiD™ MP Lib Seq — Tag 1 Primer A Reagents

S
h

SOLID™ Mixing Strip Tube
SOLIiD™ MP Lib Seq — Tag 2 Primer E Reagents
SOLIiD™ MP Lib Seq - Tag 2 Primer D Reagents
SOLiD™ MP Lib Seq — Tag 2 Primer C Reagents

SOLiD™ MP Lib Seq — Tag 2 Primer B Reagents

SOLiD™ MP Lib Seq — Tag 2 Primer A Reagents

Figure 28 Reagent strip block layout to sequence mate-paired tag 2 (50 bp).
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SOLID™ Frag Lib Seq— BC =\
Bridge Probes Rgnts

SOLiD™ Frag Lib Seq — BC Primers Reagents

SOLID™ Frag Lib Seq — BC Probe Reagents
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Figure 29 Reagent strip block layout to sequence barcode (5 bp).
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4. Verify that the reagent strip blocks are oriented and seated properly in the chiller
block. The block must engage the orientation key to fit properly. The orientation
key (cut corner) is in the upper-left position when the block is placed on the
instrument (see Figure 30 on page 38).
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Figure 30 The Reagent Strip Block.

IMPORTANT! Ensure that the chiller block temperature is below 10 °C before
proceeding with reagent strip installation. Under the System Status menu, select
Cooling from the Chiller drop-down menu (Figure 13 on page 23).

5. When the temperature is less than 10 °C, place the reagents in the appropriate
location in the chiller block (see Table 7 and Figure 31 on page 39).

Table 7 Where to place the strip tubes

If using flowcell... Then place the strip tube(s) in the...
1 Front block
2 Rear block
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Rear reagent strip block (Flowecell 2)

Front reagent strip block (Flowecell 1)
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Figure 31 Position of the sequencing reagent blocks for flowcells 1 and 2.

6. Place the cover over the reagent strips and secure them using the cover fasteners
(see Figure 32).

pue sapi|s ||e1sul pue aiedald g Jerdeyn

E Note: Ensure that the top and bottom of the cover is free of splattered wet or dry
reagents (see “Clean the reagent strip cover” on page 103).

Figure 32 Securely fastened reagent strip covers.
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Chapter 3

8 Set Up, Control, and Monitor the Run

This chapter covers:
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Section 3.1 Set up and perform a workflow analysis (WFA) run

Materials and equipment required

Section 3.1 Set up and perform a workflow analysis
(WFA) run

Materials and equipment required

See Appendix A on page 85 for a list of equipment, kits, and consumables necessary to
set up a workflow analysis (WFA) run.
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Workflow

Workflow

Create a WFA run
record

Detect the focus
range

Start the WFA run

Monitor the run

§ Prepare and install slide(s) and reagents (Chapter 2) )
( Create a WFt run record )
[ Detect lheftcus range )
( Start u-jwm run )
[ Hunihjﬂ're run )

Wiew the Run Log
Wiew Heat Maps
View Cycle Scans

y

View the WFA report
Ganerate WFA report

Determine the optimal titration point

Determine the bead deposition density for a sequencing run

A WFA run record is created using the SOLiD™ Instrument Control Software (ICS).

Two methods exist for determining the focus range: automatic and manual. Users
should first attempt automatic range detection. If automatic detection fails, use the
manual mode.

Start the run by using the SOLiD™ Instrument Control Software. Before starting a run,
you may need to remove previous data may need to ensure maximum disk space for
new results.

While executing a WFA run, the instrument performs a Prescan. In a Prescan, all of the
beads are labeled and their positions on the slide are recorded to derive a focal map
followed by a single ligation cycle. The run can be monitored through the ICS or the
SETS browser by using the Run Log, Heat Map, and Cycle Scans.

Each flowcell generates a separate Run Log that records high-level events, such as
fluidic modules and slide scanning. The start and stop times of these events, as well as
any pauses or errors during the run, are also recorded. The Run Log is particularly
useful in helping you anticipate and schedule reagent refills or troubleshoot instrument
errors.
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Create a WFA run record

Heat maps are generated from the analysis of the focal map images and analysis of
each ligation cycle. A heat map is a colorized display of a particular metric (bead
count, bead signal, or image signal) across all the panels for a run (for definitions of
the metrics, see the “Glossary” on page 173).

For each flowcell, the corresponding Cycle Scans window provides nearly real-time
feedback on initial data quality on a per-cycle basis.

View the WFA  You can view a WFA report in the SOLiD™ Experiment Tracking System (SETS) after
report  the run is complete. Three important metrics are generated in the WFA report: P2#/P1#
ratio, On-Axis beads, and Titration Metric. These metrics guide the selection of the
best-performing bead population based on different titration points used in ePCR (for
definitions of the metrics, see the “Glossary” on page 173). In general, the closer the
image data points are on-axis, the higher the quality of data obtained due to good bead
deposition and chemistry.
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From the WFA data, you can also estimate the bead deposition density to be used when
preparing a slide for sequencing. Differences between bead concentration measured on
the NanoDrop® ND-1000 Spectrophotometer and the concentration actually detected
by the bead counting algorithm on the instrument may occur. In order to maximize
throughput in a SOLiD™ sequencing run, a bead density of 130,000 P2-positive beads
per panel is recommended.

Create a WFA run record

There are two ways to create a WFA run. The first method is to use the Run wizard (see
below). The second method is to import a .txt file that contains the run definition (see
“Set up a run by importing a Run Definition file” on page 106). Importing a .txt file
saves time re-entering information of a repeated run. The .txt file can be generated on
an off-instrument computer.

1. Click Create Runs in the Setup task pane on the left menu pane of the ICS (see
Figure 33 on page 46).
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Figure 33 Use the run wizard to create a WFA run.

2. Complete the information in the Select Run Type and Mask pane (see Figure 34
on page 47):

a. Select the WFA option.

lop

. (Optional) Type a new run name.

. (Optional) Enter a description.

(2]

. Ensure that the mask 4_spot_ WFA_mask_sf is selected.

(o}

e. Click Next.
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Section 3.1 Set up and perform a workflow analysis (WFA) run
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Figure 34 Complete the information in the Select Run Type and Mask pane.

3. Complete the information in the Specify Samples and Analysis pane (see
Figure 35 on page 48):

a. Assign samples to spots.

b. Click Finish.
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Figure 35 Complete the information in the Specify Samples and Analysis pane.

4. Choose either to assign a run to a flowcell for immediate use or to store the run in
the instrument database for later use, then click OK.

5. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.

6. (Optional) Repeat the above steps for the other flowcell if performing a WFA run
on a second slide.
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Detect the focus range

Detect the focus range

@ Note: If automatic focus range detection fails, determine the focus range
manually (see “Manually find the focus range” on page 107).

1. Close the front doors of the SOLiD™ 3 Analyzer. Open the Imager window by
choosing Windows » Imaging System.

2. Select Tools » Detect Focusing Range.

3. In the focusing range dialog, specify the stage template file by entering the name
directly or by clicking the Browse button to navigate to a suitable one (see
Figure 36). The stage template must match the slide in the target flowcell(s). If
you created a run from the ICS, then select the file imagingMap.STG from the
subdirectory in C:\Runs whose name matches the name of the run (for example,
select C:\Runs\Solid0327_20081209_2_0Oct_Test\imagingMap.STG).

Ei Detect Focusing Range Q@@

Select Stage Template

| =] Brows|

Please select flowcel: |2 +|
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Figure 36 Detect Focusing Range dialog.

4. Select the flowcell using the drop-down menu, then press Go. The Imager works
for several minutes while it determines the range. The blue progress bar indicates
how close it is to completion (see Figure 37). You can also click Cancel so that the
Imager aborts the ranging operation.

Ei Detect Focusing Range B@@

Select Stage Template

| C:/Runs/solid0327_20081204_1x15_530uad_1/imagingMap.5TG | Browse

Flease select floweell: il |

| _Concel |

Searching focusing range at [-22218, -24504) -_

Figure 37 Detect Focusing Range Dialog while detection in progress.

5. When the Imager is done, a dialog appears (see Figure 38 on page 50). Click Yes
if you want to replace the values in the local settings file. Click No if you want the
Imager to discard the newly calculated focus range.
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Detect the focus range

G Focusing Range Detection

D , The Focus range For Flowcell 2 is:
(BEDE21, 6TOEZ1).
Do you wank bo save these For this Floweell?

Riiivesiii ol

Figure 38 Confirm that you want to replace the local settings file.

6. Verify the validity of the newly calculated focus range by taking images at random
locations.

\Bl IMPORTANT! You should see images of beads, ensuring that the algorithm

= was able to focus on the beads and not on other artifacts (see Figure 39). If
you do not see bead images or if you see out-of-focus bead images, set the
focus range manually (see “Manually find the focus range” on page 107).

Figure 39 Beads in focus.
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Start the WFA run

Start the WFA run

1. Click Start Run.

2. If there is not enough room to store the data, then the Start Run dialog displays
(see Figure 40). Choose the appropriate option (see Table 8).

;"_-. There Is not enough free disk space to complete this nun and the cumently active nuns
[ .

An additional 3,74868 is required

| Start Aryway | [Delete Images Cane
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Figure 40 This Start Run dialog appears if there is not enough room to store data
for the run.

Table 8 Choose one of the three options to manage disk space.

Option Description

Start Anyway Initiates the run. The instrument pauses
itself when it runs out of free disk space.

Delete Images* Launches Historical Runs page in SETS.
Images and/or results can be deleted
through SETS

Cancel Aborts the run.

1 For more information on creating more available disk space, see the Applied Biosystems SOLID™ 3
System SETS Software Getting Started Guide (PN 4389302).

@ IMPORTANT! Before deleting any images, ensure that data analysis from the
previous run is satisfactory and complete. For more information, refer to the
Applied Biosystems SOLiD™ 3 System SETS Software Getting Started Guide
(PN 4389302).

3. After the run has been initiated, you can click the Run Log, Cycle Scans, and
Heat Map buttons located at the top of the appropriate flowcell panel to learn
more information about the current run (see Figure 41 on page 52).
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Figure 41 How to learn more about the current run.

IMPORTANT! Do not disturb the SOLiD™ 3 Analyzer while in operation and
do not open the flowcell during a pause in the run. Significant perturbations (for

example, opening system parts, vibrations) during the run is detrimental to the
results.
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Monitor the WFA run

Monitor the WFA run

\Q Note: To monitor the run remotely, use SETS from any computer to connect to
the networked instrument [refer to the Applied Biosystems SOLiD™ 3 System
SETS Software Getting Started Guide (PN 4389302)]. If desired, set up e-mail
notification regarding the instrument run and system information using SETS
(refer to the SOLiD™ 3 System SETS Software Getting Started Guide).

View the run log 1. Click Run Log located at the top right corner of the flowcell panel. A dialog box
opens, describing a series of instrument events.
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2. After you finish viewing the Run Log, click Close, located at the bottom of the
Run Log window.

View heat maps 1. To view the heat map showing bead densities found in the focal map images, click
Heat Map located at the top right-hand corner of the flowcell panel (see Figure 41
on page 52).

2. Look for:

+ Uniform deposition of beads on the slide.

» The actual average bead deposition density/panel value being similar in value
to the targeted average bead deposition density/panel of 25,000 beads/panel
for WFA run. A large number of missing panels could indicate a deposition
problem.

E Note: The heat map may not immediately be available after the completion
of the Prescan. The software must process all the images collected during
the Prescan before the heat map is available. This process may take up to
30 minutes, depending on the number of panels imaged.

3. After you finish viewing the Heat Map, click Close located at the bottom of the
Heat Map window.

View cycle scans 1. Select the appropriate flowcell (Flow Cell 1 or Flow Cell 2) in the Cycle Scan
menu on the task bar on the left.

Q Note: Details regarding which parameters to monitor are described in the

b sequencing run section (see “Monitor the sequencing run” on page 78).

2. Double-click any cycle to view the heat map for that cycle (see Figure 65 on
page 82).

3. Left-click any square panel on the heat map to open the panel browser window.
The panel browser allows you to view the focal map and the image for each
fluorescent dye signal (see Figure 66 on page 83).
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View the WFA report

4. After you finish viewing the Cycle Scans, close the Cycle Scans window.

E Note: If the WFA run appears problematic, you can: (1) Allow the run to
continue and troubleshoot after the run or (2) pause the run and troubleshoot.
Consult an Applied Biosystems SOLiD™ Field Applications Specialist.

View the WFA report

Generate the WFA  The WFA report is automatically generated and available in SETS when the WFA run
report finishes (see Figure 42). Refer to the Applied Biosystems SOLiD™ 3 System SETS
Software Getting Started Guide (PN 4389302).
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Figure 42 One WFA report for a single 4-well slide displayed in SETS.

Determine the Determine which titration has the highest titration metric. This titration is the optimal
optimal titration titration point.
point

Determine the bead 1. Calculate the concentration of P2-positive beads using the formula below, where X
deposition density is the volume of templated beads used for the WFA sample (equivalent to 15

fora sequenc:zg million beads) and P2# is given by the WFA report:
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15 x 10° beads
# beads/pL (according to ManoDrop ™)

P2# beads/panel ® 432 panels
XuL

XpL =

¥ P2-positive beads/pL =

Example:
For a sample with a concentration of 500,000 beads/pL measured by ManoDrop ™

NO-1000, where the WFA report indicates a P2# value of 20,000 beads/panel.

15 = 10° beads
500,000 beads/uL

20,000 beads/panel = 432 panels
30 ul

XuL = = 30 uL
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Y P2-positive beads/uL =

= 288,000 P2-positive beads/pL

2. Use the calculated concentration in place of the value determined by the
NanoDrop® ND-1000 Spectrophotometer for more accurate deposition densities
when preparing slides for sequencing. It is recommended to use this resulting
calculated bead concentration to determine the volume of beads for deposition.
Then, multiply that volume by 120% to calculate the volume of beads for
deposition:

Desired # P2-positive beads to be deposited
Z L bead solution = x 120%
Y P2-positive beads/pL

Example:
For a sample with a concentration of 288,000 P2-positive beads/pL to be deposited in
one well of an 8-well SOLID™ Deposition Chamber at a density of 130,000 beads/panel.

30 million P2-positive beads
Z L bead solution = x 120%
288,000 P2-positive beads/uL

= 125 L bead solution
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Materials and equipment required

Section 3.2 Set up and perform a sequencing run

Materials and equipment required

See Appendix A on page 85 for a list of equipment, kits, and consumables necessary to
set up a sequencing run.
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Workflow

Workflow

( Prepare and install slide(s) and reagents (Chapter 2) )
|
Create a sequencing (standard) Create a multiplex sequencing
run record run record

Y

[: Detect the focus range ]
( Start the sequencing run )
|
Control the run Munltnr the run
Pausefresume run Yiew the Run Log
Use the Run Contral menu I View the Heat Maps

Lise image controls View Cycle Scans

Create a A sequencing (standard) run record is created using the SOLiD"™ Instrument Control
sequencing  Software (ICS). Primary Analysis Settings and Secondary Analysis Settings should be
(standard) rug created prior to creating a sequencing run record using SETS [refer to the Applied
record  Biosystems SOLiD™ 3 SETS Software Guide (PN 4389302)].

Create a multiplex A multiplex sequencing run record is created using the SOLiD™ Instrument Control
sequencing run  Software (ICS). At this step, barcodes are matched to libraries. Primary Analysis
record Settings and Secondary Analysis Settings should be created prior to creating a
sequencing run record using SETS [refer to the Applied Biosystems SOLiD™ 3 SETS
Software Guide (PN 4389302)].

Detect the focus  Two methods exist for determining the focus range: automatic and manual. Users
rangeé should first attempt automatic range detection. If automatic detection fails, use the
manual mode.

Start the  The run is started using the SOLiD™ Instrument Control Software. Before starting a
sequencing run  run, previous data should be removed to ensure maximum disk space for new results.
The instrument is limited to run 5 primers per flowcell. If you are sequencing mate
pairs or barcoded fragments, the instrument automatically pauses and stays paused
until the reagents are replaced and the run is resumed.
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Create a sequencing (standard) run record

Control the run  You can control how the SOLiD™ 3 System collects sequencing data with the SOLiD™
Instrument Control Software (ICS). With the ICS, you can repeat a primer to improve
the real-time primary analysis results or set an early pause point to change reagents on
your schedule. You can choose to turn off imaging of specific samples to collect only
the best sequencing data.

To control the ICS, use the Run Control drop-down menu. Use the Run Control menu
only if you understand clearly the series of fluidic and imaging steps in a run. Skipping
or repeating certain steps could lead to errors in the resulting data. For example, with
the ICS menus, you can repeat a ligation; however, you must first cleave the fluorescent
label from the ligation product.
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Monitor the run  While executing a sequencing run, the instrument performs a Prescan. In a Prescan, all
of the beads are labeled and their positions on the slide are recorded to derive a focal
map followed by a single ligation cycle. The run can be monitored using the Run Log,
Heat Map, and Cycle Scans through the Instrument Control Software (ICS) or from the
SETS browser.

Each flowcell generates a separate Run Log that records high-level events, such as
fluidic modules and slide scanning. The start and stop times of these events and any
pauses or errors that occur during the run, are also recorded. The Run Log is
particularly useful in helping you anticipate and schedule reagent refills or
troubleshoot instrument errors.

Heat maps are generated from the analysis of the focal map images and analysis of
each ligation cycle. A heat map is a colorized display of a particular metric (bead
count, bead signal, or image signal) across all the panels for a run (for definitions of
the metrics, see the “Glossary” on page 173).

For each flowcell, the corresponding Cycle Scans window provides nearly real-time
feedback on initial data quality on a per-cycle basis.

Create a sequencing (standard) run record

A Note: For instructions to set up a multiplex sequencing run record, go to the
next section “Create a multiplex sequencing run record” on page 63.

There are two ways to create a sequencing run. The first method is to use the Run
wizard (see below). The second method is to import a .txt file that contains the run
definition (see “Set up a run by importing a Run Definition file”” on page 106). It saves
time re-entering information of a repeated run. This file can be generated on an off-
instrument computer.

1. Click Create Runs in the Setup task pane on the left menu pane of the ICS (see
Figure 43 on page 60).
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Figure 43 Use the run wizard to create a sequencing run.

2. Complete the information in the Select Run Type and Mask pane (see Figure 44
on page 61):

a. Select the Sequencing option.

b. (Optional) Type a new run name.

c. (Optional) Enter a description.

d. Ensure that the Run Protocol is set to SOLiD3.

e. Select Primer Set 1 and Primer Set 2.
+ If sequencing a fragment library, leave F3 as Primer Set 1.

» Ifsequencing a mate-paired library, select R3 as Primer Set 1 and F3 for
Primer Set 2.

IMPORTANT! R3 tag must be run first in a mate-paired
sequencing run. The reagent strips for the F3 tag do not contain
Focal Map reagents.

f. Enter read lengths for Primer Set 1, and if used, 2. A typical read length is 50
bases.

g. Select Primary Analysis Settings and Secondary Analysis Settings that are
the defaults for the run.

h. Select the appropriate mask to use.
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Create a sequencing (standard) run record
i. Click Next.

@ Note: Ifa message window appears during these steps, then continue setting up
run as indicated. If a message remains after all selections have been made,
correct the entries before clicking Next.
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Figure 44 Complete the information in the Select Run Type and Mask pane.

3. Complete the information in the Specify Samples and Analysis pane (see
Figure 45 on page 62):

a. Select the number of samples that will be used in the run. If a single sample
will be run in multiple spots of the same slide, it counts as only one sample.
Otherwise, the number of samples typically matches the number of spots on
the mask.

b. (Optional) Edit the Sample Name, Library, Analysis settings, and
Description.
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Figure 45 Complete the information in the Specify Samples and Analysis pane.

4. Assign Samples to spots in the mask. A blue or white circle on the mask indicates
that the numbered sample has been assigned to a spot. Clicking on a white circle
selects that spot, and clicking on a blue circle un-assigns that spot. To assign a

sample, select it from the Sample list, then click on a spot with no sample assigned
to it.

5. Choose either to assign run to a flowcell for immediate use or to an instrument
database to store for later use, then click OK.

6. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.
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Create a multiplex sequencing run record

\g Note: For instructions to set up a sequencing (standard) run record, go to the
previous section “Create a sequencing (standard) run record” on page 59.

There are two ways to create a multiplex sequencing run. The first method is to use the
Run wizard (see below). The second method is to import a Run Definition file created
offline (see “Set up a run by importing a Run Definition file” on page 106).

1. Click Create Runs in the Setup task pane on the left menu pane of the ICS (see
Figure 46).
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Figure 46 Use the run wizard to create a multiplex sequencing run.

2. Complete the information in the Select Run Type and Mask pane (see Figure 47
on page 64):

Select the Sequencing option.

IS

Ensure that the Multiplexing option is checked.

c. (Optional) Type a new run name.

d. (Optional) Enter a description.

e. Ensure that the Run Protocol is set to SOLiD3_Multiplex.

f. Select BC for Primer Set 1. Enter the read length for the BC Primer set,
which is usually 5 bases.

SOLID™ 3 System Instrument Operation Guide 63



8 Chapter 3 Set Up, Control, and Monitor the Run
Create a multiplex sequencing run record

d. Select F3 for Primer Set 2. Enter the read length for the F3 Primer sets, which
is usually 50 bases.

Note: For barcoded fragment libraries of short inserts such as small RNA
samples, consult your field applications specialist for the recommended
sequencing reagents and read length.

h. Select Primary Analysis Settings and Secondary Analysis Settings that are
the defaults for the run.

i. Select the appropriate mask to use.

j. Click Next.

\Q Note: Ifamessage window appears during these steps, then continue setting up
run as indicated. If a message remains after all selections have been made,
correct the entries before clicking Next.
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Figure 47 Complete the information in the Select Run Type and Mask pane.
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3. Complete the information in the Specify Samples and Analysis pane (see
Figure 48 on page 65):

a. Select the number of samples that will be used in the run. A sample consists
of a bead sample that may contain many barcoded libraries. A single sample
will run in multiple spots on the same slide counts as only one sample;
otherwise, the number of samples typically matches the number of spots on
the mask.

b. Click the first sample name to select it. Change the sample name if desired.
After you select the sample, you are able to enter the names and other
information about the libraries that are in the sample.
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Figure 48 Complete the information in the Specify Samples and Analysis pane.
4. Click Create New Library to begin entering library information.

5. Enter information for the first library present in the sample (see Figure 49 on
page 66):
a. Enter the library name.

b. Select a Multiplexing Series.

c. Click the selection box for the barcode or barcodes assigned to the library.
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d. Click Save when information for the first library has been completed.

E Note: When entering information on the library, follow these
guidelines:
* Only barcodes from a single Multiplexing Series may be used in
any individual sample.

* Each barcode may only be assigned to a single library per sample,
but a single library may have multiple barcodes.

* The read length of the barcode tag is a property of the
Multiplexing Series. Thus Multiplexing Series defined with 5-
base barcodes may only be sequenced with 5 base reads of the BC
tag (see Table 9 on page 67).

The Libraries panel of the Specify Samples and Analysis screen now shows
information on the first library.

- Create New Library F|

For each lbeary present in a muttiplesed sample, enter a Lbeary Name, select the Multiplexing Seres used, and specify which Barcode(s) have
been added during that lorary's craation.

Library Nama: bl

1) Seleck Multiphecdng Saries 2) Select Barcodes [ ] Sebect &l 3) Review sebecbed baroodes for this lbrary

Multiplexing Series A (1-10) bealo_01 Mudtiplesing Sertl:i A(1-10) (2)
A10_D1
[+] beato_oz bcAlD_02

[ bcAlO_04
[ beato_os
[]beain_né
[ beato_o7
[ beato_os
[ beata_ie
[ beato_1o

More abiout the Selacted Multiplecdng Series

Thes saries contains the 10 barcodes contaned in
the original SOUD Small RMNA Expression kit

[_save J[concel

Figure 49 Enter the information for the libraries in the sample.
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Table 9 Contents of the Multiplexing Series

Multiplexing Series Contents
A (1-10) 10 barcodes that are in the SOLID™ Small
RNA Expression Kit
A (1-16) 16 barcodes that are in the SOLID™
Multiplexing Early Access set
B (1-20) 20 barcodes that are supplied with the
SOLID™ 3 System

6. Repeat steps 4 to 5 for all remaining libraries.The Libraries panel of the Specify
Samples and Analysis screen now shows information for all libraries (see
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Figure 50).
*How marry samples will you need For your mask? |1 v
Sample Name Frimary Analysis Secondary Analysis Description Remove
bcSamplel <run defaulk > w | <run defaul > w x
Create New Libeary | Flease select a sample inthe above table to define s libearies. libl Details
Library Name #Fharcodes Genome Reference Override Multiplexing Series Options Selected Barcodes
b1 2 Multiplexing Series A {1-10) # X bealo_01

beAl0_02

Figure 50 The Libraries panel shows information on all libraries.

7. If any library uses a Genome Reference other than the default, enter the exact
name of the Genome Reference fasta file, including the .fasta extension.

8. Assign samples to spots in the mask. A blue or white circle on the mask indicates
that the numbered sample has been assigned to a spot. Clicking on a white circle
selects that spot, and clicking on a blue circle un-assigns that spot. To assign a
sample, select it from the Sample list, then click on a spot with no sample assigned
to it.

9. Click Finish.

10. Choose to assign the run to a flowcell for immediate use or to an instrument
database to store for later use, then click OK.

11. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.

c. Choose a flowcell, then click OK.
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Detect the focus range

Note: If automatic focus range detection fails, determine the focus range
manually (see “Manually find the focus range” on page 107).

1. Close the front doors of the SOLiD™ 3 Analyzer. Open the Imager window by
choosing Windows » Imaging System.

2. Select Tools » Detect Focusing Range.

3. In the focusing range dialog, specify the stage template file by entering the name
directly or by clicking the Browse button to navigate to a suitable one (see
Figure 51). The stage template must match the slide in the target flowcell(s). If
you created a run from the ICS, then select the file imagingMap.STG from the
subdirectory in C:\Runs whose name matches the name of the run (for example,
select C:\Runs\Solid0327_20081209_2_0Oct_Test\imagingMap.STG).

v Detect Focusing Range

Select Stage Template

EEX

Flease select flowcel. [2 =]
Go |

] e

Cancel |

IDLE

—

Figure 51 Detect Focusing Range dialog.

4. Select the flowcell using the drop-down menu, then press Go. The Imager works
for several minutes while it determines the range. The blue progress bar indicates
how close it is to completion (see Figure 52). You can also click Cancel so that the

Imager aborts the ranging operation.

v Detect Focusing Range
Select Stage Template

EEX

Flease select floweell: il |

| C:/Runs/zolid0327_20081204_1x15_530uad_1/imagingMap STG

| _Corcel |

_~| Browse

Searching focusing range at [-22218, -24504)

Figure 52 Detect Focusing Range Dialog while detection in progress.

5. When the Imager is done, a dialog appears (see Figure 53 on page 69). Click Yes
if you want to replace the values in the local settings file. Click No if you want the
Imager to discard the newly calculated focus range.

68
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[i Focusing Range Detection

9P ) The focus range For Floweell 2 is:
-
(BEDE21, 6TOEZ1).
Do vou wank bo save these For this Flowecell?

fiivesii ol

Figure 53 Confirm that you want to replace the local settings file.
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6. Verify the validity of the newly calculated focus range by taking images at random
locations.

IMPORTANT! You should see images of beads, ensuring that the algorithm
was able to focus on the beads and not on other artifacts (see Figure 54). If
you do not see bead images or if you see out-of-focus bead images, set the
focus range manually (see “Manually find the focus range” on page 107).

Figure 54 Beads in focus.
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Start the sequencing run

1. Ensure that there is adequate disk space for images and results of the sequence run
(for the minimum needed disk space, see Table 10). To know the amount of disk
space that is available, click Manage Runs on the task pane.

Table 10 Minimum required disk space to store images and results

Run Type Minimt;cr,r: ?rﬁz‘;i :eeded Minimtjf?rsrzzsletsneeded
Fragment (50 bp) 1.9TB 700 GB
Mate-paired (2 x 25 bp) 1.97TB 700 GB
Mate-paired (2 x 50 bp) 3.8TB 1.4TB
Bircoded fragment (50, 5 2.17TB 770 GB

2. Click Start Run.

3. If there is not enough room to store the data for the run then the Start Run dialog
box displays (see Figure 55). Choose the appropriate option (see Table 11).

L\u There Is not enough free disk space to complete this nun and the cumently active nuns
An additional 3, 7988 is required

| Start Aryway | |Delete Images... Cance

Figure 55 This Start Run dialog appears if there is not enough room to store data
for the run.

Table 11 Choose one of the three options to manage disk space.

Option Description

Start Anyway Initiates the run. The instrument pauses
itself when it runs out of free disk space.

Delete Images* Launches Historical Runs page in SETS.
Images and/or results can be deleted
through SETS

Cancel Aborts the run.

t For more information on creating more available disk space, see the Applied Biosystems SOLID™ 3
System SETS Software Getting Started Guide (PN 4389302).

@ IMPORTANT! Before deleting any images, ensure that data analysis from the
previous run is satisfactory and complete. For more information, refer to the
Applied Biosystems SOLiD™ 3 System SETS Software Getting Started Guide
(PN 4389302).
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4. After the run has been initiated, you can click the Run Log and Heat Map buttons
located at the top of the appropriate flowcell panel to learn more information
about the current run Figure 56. You can also use select the appropriate flowcell in
the Cycle Scans menu on the task bar on the left
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Figure 56 How to learn more about the current run.

@ IMPORTANT! Do not disturb the SOLiD™ 3 Analyzer while in operation and
do not open the flowcell during a pause in the run. Significant perturbations (for
example, opening system parts, vibrations) during the run is detrimental to the
results.
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Control the run

Pause/Resume Run  Five modules contain a pre-mixing step for the next module:
+ Ligate/Dark Ligate Mix
» Dark Ligate/Phosphatase Mix
* Cleave/Ligate Mix
* Prime/Bridge Ligate Mix
» Bridge Ligate/Phosphatase Mix

When you try to pause a run in the middle of the module, a dialog displays (see
Figure 57).

i~ Pause Run

This module contains pre-mixing.
Select the type of pause to perform.

How do you want to pause the run?

Pause after current module completes v

Recommended pause. Pauses the run after the
current module completes. On resume of the run,
execution will begin with the next scheduled module.

| ok || cancel |

Figure 57 Pause Run dialog for pre-mixing module.

The default setting is to pause after the current module completes so that pre-mixing is
not interrupted. If you want to pause the run within a pre-mixing module, select Pause
anyway (see Figure 58 on page 73).
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i~z Pause Run

This module contains pre-mixing.
Selectthe type of pause to perform.

How do you want to pause the run’?

| Pause anyway |

Pause after current module completes
Fauses the run afier abording the current module. Tn

resume of the run, resume ar remix script will be
executed prior to the execution of the current module.
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Figure 58 Pause Run dialog options for pre-mixing module.

When you resume a run to use the pre-mixed reagents in the strip tube, a dialog box
displays (see Figure 59). While it is recommended to simply resume the run, the system
provides an option to remix the reagents by clicking Remix/Resume. In this case, the
previous pre-mixed reagent is delivered to the waste and a new reagent is mixed.

Resume - Remix/Resume

(Recommended if pausing kime is < 1 hour.)

{1 Remix/Resume
Waste the existing pre-mixed reagents and make a new mixed reagent.,
(Recommeded if pausing time is = 1 hour.)

Figure 59 The options to resume or remix/resume the run are available.

\g Note: One reagent strip contains reagents enough for 10 cycles per primer.
Therefore, if the remix option is used, the cycle number which can be used with
the reagent strip is reduced.
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Use the Run 1. Click Run Control to display the Run Control menu (see Figure 60).
Control menu
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Figure 60 Click Run Control to display the Run Control menu for that flowcell.

Run Control commands (see Table 12)

(1) IMPORTANT! Do not disturb the SOLiD™ 3 Analyzer while in operation and do
not open the flowcell during a pause in the run. Significant perturbations (for

example, opening system parts, vibrations) during the run is detrimental to the
results.

Table 12 Run Control commands

" Command is available while the
Command instrument is...

Stop Run Running or paused

Reset Current Primer Paused within Primer Cycle

Change Primer Schedule Paused

Set Early Pause Point Running or paused

Change Run Progress Point Paused

¥ Certain commands have sub-menus that allow you to control every step in a run protocol.
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Stop Run

The Stop Run command launches a Stop Run dialog box. Choose the appropriate
option in the dialog according to Table 13.

Table 13 Options available in the Stop Run dialog

Option Description
Abort Run Run aborts and analysis jobs are cancelled.
Set run as completed Run is set as completed. Secondary
analysis jobs starts.
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Change Primer Schedule

The Change Primer Schedule command allows you to choose a first and second primer,
in any order, from primers A through E of any of the three primer sets (F3/R3/BC).
Depending on how you set up the run, only primers from a selected primer set are
available in the sub-menu.

Set Early Pause Point

The Set Early Pause Point command allows you to define when the instrument pauses.
This command can be used to replenish reagents at a more convenient time than that
the time defined by the software. Note that if the Change Run Progress Point command
(see below) is selected, any changes to the Early Pause Point resets to the default.

Depending on the progress of the run, various sub-menu commands are available under
the Set Early Pause Point (see Figure 61 on page 76).
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+ Prescan
o Reset
o P2 Label
o Image Prep
o Focus Map
¢ Sequence Primer A and B
o Priming
= Reset
= Prme/Ligate Mix
o Ligation
= Ligate/Dark Ligate Mix

®  Dark Ligate/Phosphatase Mix
®  Phosphatase
=  Image Prep
= Scan Slide
=  Cleave/Ligate Mix
¢ Sequence PrimerC, D, and E
o Priming
= Reset

= Prme/Bridge Ligate Mix
® Brdge Ligate/Phosphatase Mix
®  Phosphatase
=  Cleave/Ligate Mix
o Ligation
= Ligate/Dark Ligate Mix

®  Dark Ligate/Phosphatase Mix
®  Phosphatase
=  Image Prep
= Scan Slide
=  Cleave/Ligate Mix
+ Slide Store
o Store

Figure 61 Set Early Pause Point sub-menu commands.

Change Run Progress Point

The Change Run Progress Point command allows you to back up or skip to any specific
point in the run. Ensure that you select points that are consistent with the progress of
the run. The choices available under the Change Run Progress Point command include
those described above for the Set Early Pause Point command.

Repeating primers can be performed by using the Change Run Progress Point
command, selecting a primer to repeat, resuming the run, and using the Set Early Pause
Point command to pause the run after the repeated primer has completed.

Use imaging and  The Instrument Control Software (ICS) allows you to control imaging for individual
analysis controls  samples on a slide. With the controls, you can deposit fragment and mate-paired library
for speC|If|c samples onto the same slide and turn off imaging of a sample. To access the imaging
Samples  nd analysis controls, in the Sample Slide display of the ICS, right-mouse click a
sample name to display options menu. These options are not available until the focal
map (prescan) is complete.

The options menu includes:

» Enabled
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* Imaging Turned Off
* Spot discarded

Enabled
Enabled is the default setting and allows for both imaging and analysis of the spot.

Imaging Turned Off

Imaging Turned Off turns off imaging but allows analysis to complete.

Spot Discarded
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Spot Discarded turns off both imaging and analysis. Spot Discarded can be used to
remove problematic samples from the software workflow. Use of Spot Discarded
updates the Sample Slide display according to the selection in Spot Discarded. Use of
Spot Discarded also affects subsequent cycles (see Figure 62).

Figure 62 The Sample Slide display updates after using Imaging Turned Off or
Spot Discarded.
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Monitor the sequencing run

\Q Note: To monitor the run remotely, use SETS from any computer to connect to
the networked instrument [refer to the Applied Biosystems SOLiD™ 3 System
SETS Software Getting Started Guide (PN 4389302)]. If desired, set up e-mail
notification regarding instrument run and system information using SETS (refer
to the SOLiD™ 3 System SETS Software Getting Started Guide).

View the run log 1. Click Run Log located at the top right corner of the flowcell panel to open a
dialog box describing a series of instrument events.

2. After you finish viewing the Run Log, click Close located at the bottom of the
Run Log window.

View heat maps 1. To view the heat map showing bead densities found in the focal map images, click
Heat Map located at the top right corner of the flowcell panel (see Figure 63 on
page 79).

2. Look for:
+ Uniform deposition of beads on the slide.

* The actual average bead deposition density/panel value being similar in value
to the targeted average bead deposition density (for example, 130,000
beads/panel). A large number of missing panels could indicate a deposition
problem.

\Q Note: The heat map may not immediately be available after the completion
of the Prescan. The software must process all the images collected during
the Prescan before the heat map is available. This process may take up to
30 minutes depending on the number of panels imaged.

3. After you finish viewing the Heat Map, click Close located at the bottom of the
Heat Map window.
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Section 3.2 Set up and perform a sequencing run
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Figure 63 Bead Count (left), Bead Signal (center), and Image Signal (right) heat
maps.

1.

menu on the task bar on the left.

The top section of the Cycle Scans window lists all the scans per ligation cycle for
the slide, and the bottom section shows scan information sorted by sample for the
scan selected in the top section. Use the parameters shown in Figure 64 on
page 80 to assess the progress of the sequencing run (see Table 14 on page 81).
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Figure 64 Parameters available in the Cycle Scans window to assess the progress
of the sequencing run.
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Monitor the sequencing run

Table 14 Use the Cycle Scans window to distinguish normal runs from problematic runs.

Parameter

Normal run

Problematic run

(1) Failed panels (humber of
panels that failed image
alignment during color-calling).

(2) The fraction of (Best + good
beads)/usable beads

Gradual decline from ligation
cycle 1 to ligation cycle 5 or
higher for each sequencing
primer. In general, the number of
failed panels should be relatively
small and consistent.

The fraction can vary depending
on the quality of the library, the
efficiency of the PCR and the
enrichment process. As a
guideline, the fraction is around
0.5 to 0.6 in the first ligation cycle
of each primer and drops to 0.2
to 0.3 in the last cycle.

Run begins with extremely high
number of failed panels or
dramatic increase in any
subsequent ligation cycle for
each sequencing primer.

A significant drop in the fraction
of good beads in the initial
ligation cycles would indicate a
reason to pause the run and to
troubleshoot the performance.

(3a/3b) Effective exposure times*

(4) Satay plots

Gradual increase from ligation
cycles 1 to 5 or higher for each
sequence primer. Performance
varies from slide to slide and as a
function of the age of the
SOLID™ Light Source.§ As a
guideline, the effective exposure
time is typically 50 to 200 ms in
the first ligation cycle and
increases to 500 to 1000 ms in
the fifth cycle.

The first cycle of any primer
should show a relatively “clean”
Satay plot, with most points
clustered on the four color axes
and with minimal fraction of the
points clustered around the
origin. The quality of the Satay
plot typically degrades gradually
with each ligation cycle for a
single primer cycle, becoming
more “fuzzy” in the last cycle.

One second or greater in ligation
cycle 1 or when instrument times
out when the effective exposure
time exceeds 2 s. Long exposure
times may indicate replacement
of the SOLiD™ Light Source.$

An abnormal “fuzzy” Satay plot in
the first cycle is a reason to pause
the run and troubleshoot the
performance.

I Exposure time is indicative of the signal intensity of the beads. The instrument uses an auto-exposure routine, on a per

sample basis, to maximize bead signal with minimal image saturation. Shorter exposure times are associated with efficient

ligation of the fluorescent probes.

§ You should replace the SOLID™ Light Source in the Applied Biosystems SOLID™ 3 Analyzer every 1500 hours of use. Refer

to Appendix B for instructions.

2. Double-click any cycle to view the heat map for that cycle (see Figure 65 on

page 82).
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Figure 65 Double-click any cycle to view the heat map for that cycle.

3. Left-click any square panel on the heat map to open the panel browser window.
The panel browser allows you to view the focal map and the image for each
fluorescent dye signal (see Figure 66 on page 83).

82 SOLID™ 3 System Instrument Operation Guide



Section 3.2 Set up and perform a sequencing run 3
Monitor the sequencing run

acBd 0] _FDoE1 IEFSSpm 0 - FI P10 W1 - 1907 - 50000 Pane] Browsar

Q
=0
Y

gl
-
(0]
=
w
w
0]
—
c

¥
O
o
=)
=3
=
o
(W)
=}
(o}
=
o
=)
=
o
=

FOLA ra o
oI _STONIH 1300 | B0 0001 1T | o000 113
(RUIE = BE A PUTAEE & 10y (ELIRT = L B S

Lo Sy SR e o) M D, Maa G 0 M

[
N _ X 1) T
FliTam Eal

iy B, Mt 5

=" ¢ wwmhiggh. = D LT T e = | ik e

Figure 66 View the focal map and the image for each fluorescent dye signal.

4. After you finish viewing the Cycle Scans, close the Cycle Scans window.

\g Note: If the sequencing run appear problematic, you can: (1) Allow the run to
continue and troubleshoot after the run or (2) pause the run and troubleshoot.
Consult an Applied Biosystems SOLiD™ Field Applications Specialist.
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Set up and perform a workflow analysis (WFA) run

Set up and perform a workflow analysis (WFA) run

Required Applied
Biosystems reagent
kits

Item (part number)

Components

Kit component(s) used
in...

SOLiD™ Workflow Analysis
Reagents (4406463)

SOLiD™ Workflow Analysis
Reagents

WFA

SOLiID™ 3 Instrument Buffer
Kit (4406479)

SOLID™ Slide Pack Kit
(4412172)

SOLID™ Bead Deposition
Kit (4387895)

Reset Buffer

Glycerol

10X Instrument Buffer
Cleave Solution 1

Cleave 2 Kit (Cleave 2 Parts
1and 2)

Storage Buffer

Imaging Buffer Kit (Imaging
Buffer Parts 1 and 2)

1X T4 Ligase Buffer Kit (1X
Ligase Buffer Parts 1 and 2)

1X Phosphatase Buffer
Slide Storage Buffer
Sequencing Slides
Deposition Buffer

Overlay Buffer

Sequencing and/or WFA

Bead deposition

Bead deposition

10X Terminal Transferase
Buffer

10X Cobalt chloride
Terminal Transferase
Bead Linker

Templated bead
preparation

Required

. 3
equipment ltem

Source

SOLID™ 3 System

¢ Applied Biosystems
4406205 (110 V)

¢ Applied Biosystems
4406208 (220 V)

Upgrade Kit from SOLID™ 2.0 to SOLID™ 3

4409522

Applied Biosystems

SOLID™ 3 Analyzer

4406207

Applied Biosystems

SOLID™ Light Source

SOLiD™ Slide Storage Chamber

4388441

4406354

Applied Biosystems

Applied Biosystems

86
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Set up and perform a workflow analysis (WFA) run

Item#

Source

SOLiD™ Deposition Chambers 1-Well$

Applied Biosystems
4406352

SOLID™ Deposition Chambers 4-Wells$

Applied Biosystems
4406358

SOLID™ Deposition Chambers 8-Wells$

SOLiD™ Slide Carriers$

SOLiD™ Uninterruptible Power Supply (UPS)

SOLiID™ Offline Cluster

Applied Biosystems
4406359

Applied Biosystems
4406360

e Applied Biosystems
4397781 (SOLID™ UPS North America)
¢ Applied Biosystems
4393695 (220 V;
SOLID™ UPS International)
e Applied Biosystems
4413002 (North America)
¢ Applied Biosystems

4425588 (International)
SOLiID™ Accessory Disk Drive Applied Biosystems
4426101
SOLID™ Bead Concentration Chart Applied Biosystems
4415131
Covaris™ S2 System ¢ Applied Biosystems
4387833 (110V)
(110 V for U.S. customers) * Applied Biosystems
(220 V for international customers) 4392718 (220 V)
or

The system includes:

¢ Covaris™ S2 sonicator
e Latitude™ laptop from Dell® Inc.
e MultiTemp lll Thermostatic Circulator

e Covaris-2 series Machine Holder for (one)
1.5-mL microcentrifuge tube

e Covaris-2 series Machine Holder for (one)
0.65-mL microcentrifuge tube

e Covaris-2 series Machine Holder for (one)
13 mm x 65 mm tube

For system materials summary, see
“Covaris™ S2 System Materials Summary,”
SOLiD™ 3 System Site Preparation Guide.

6-Tube Magnetic Stand

Microcentrifuge 5417R, refrigerated, without
rotor

Covaris™ Inc.

Applied Biosystems
AM10055
¢ Eppendorf*

022621807 (120 V/60 Hz)
¢ Eppendorf*

022621840 (230 V/50 Hz)

SOLID™ 3 System Instrument Operation Guide
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Appendix A Required Materials
Set up and perform a workflow analysis (WFA) run

Required
consumables

ltem#

Source

FA-45-24-11, fixed-angle rotor,
24 x 1.5/2 mL, including aluminum lid,
aerosol-tight

Eppendorf*
022636006

NanoDrop® ND-1000 Spectrophotometer
(computer required)

Thermo Scientific

ND-1000

Scienceware Dry-Keeper AutoDesiccator VWR
Cabinet, Tall 24983-455
Tabletop Centrifuge (for 96-well plate) MLS*H
Vortexer MLS
Picofuge MLS
Magnetic stirrer MLS
Incubator (37 °C) MLS
Refrigerator (4 °C) MLS
Freezer (— 20 °C) MLS
Pipettors, 20 pL MLS
Pipettors, 200 L MLS
Pipettors, 1000 pL MLS

1 Applied Biosystems has validated this protocol using this specific material. Substitution may adversely

affect system performance.

§ The SOLID™ 3 Analyzer is shipped with 2 of each size Deposition Chambers and Slide Carriers. Two Slide
Storage Chambers are provided for use with all chambers.

# Or equivalent but validation of the equipment for library preparation is required.
11 For the MSDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant

precautions.

ltem#

Source

SOLID™ Flowcell O-rings, 10-pack

Applied Biosystems

4398217

Nuclease-free water Applied Biosystems
AM9932

ABgene® 96 1.2-mL square-well storage ABgene

PEES AB-1127

3-mm adhesive disks Grace Bio-Labs
ST200

Ethylene glycol

CF-1 Calibration Fluid Kit

PR-1 Conditioning Kit$

American Bioanalytical
AB00455-01000
Thermo Scientific
CF-1

Thermo Scientific
PR-1
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Set up and perform a workflow analysis (WFA) run

Item# Source
1.5-mL LoBind Tubes Eppendorf
022431021
Kimwipes® MLS#
Filtered pipettor tips MLS

T Applied Biosystems has validated this protocol using this specific material. Substitution may adversely
affect system performance.

§ The NanoDrop® Conditioning Kit is useful for “reconditioning” the sample measurement pedestals to a
hydrophobic state if they become “unconditioned” (see NanoDrop user’s manual for more information).
The PR-1 kit consists of a container of specially formulated polishing compound and a supply of
convenient applicators.

# Forthe MSDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant
precautions.
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Set up and perform a sequencing run

Required Applied

Biosystems reagent Item (part number) Components Kit °°mp‘i’:e"t(s) used
kits
SOLiD™ Fragment Library SOLID™ Frag Lib Seq - Fragment sequencing
Sequencing Kit — Master Primer A Reagents

Mix 50 (4406370) SOLID™ Frag Lib Seq -

Primer B Reagents
SOLID™ Frag Lib Seq -
Primer C Reagents
SOLID™ Frag Lib Seq -
Primer D Reagents

SOLID™ Frag Lib Seq -
Primer E Reagents

SOLiD™ Mixing Strip Tube

SOLID™ Mate-Paired SOLID™MP Lib Seq-Tag1 | Mate-pair sequencing
Library Sequencing Kit Primer A Reagents
(4406398)

SOLID™ MP Lib Seq-Tag 1
Primer B Reagents

SOLID™ MP Lib Seq - Tag 1
Primer C Reagents

SOLID™ MP Lib Seq - Tag 1
Primer D Reagents

SOLID™ MP Lib Seq - Tag 1
Primer E Reagents

SOLID™ MP Lib Seq - Tag 2
Primer A Reagents

SOLID™ MP Lib Seq - Tag 2
Primer B Reagents

SOLID™ MP Lib Seq - Tag 2
Primer C Reagents

SOLiID™ MP Lib Seq - Tag 2
Primer D Reagents

SOLiID™ MP Lib Seq - Tag 2

Primer E Reagents

SOLiID™ Mixing Strip Tubes
SOLiD™ Fragment Library SOLID™ Frag Lib Seq-BC | Barcode sequencing
Sequencing Kit — Barcode Probe Reagents

SEEEANEAT) SOLID™ Frag Lib Seq - BC
Primers Reagents
SOLID™ Frag Lib Seq - BC
Bridge Probes Reagents
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Set up and perform a sequencing run

Item (part number) Components Kit compti):ent(s) used
SOLiD™ 3 Instrument Buffer =~ — Reset Buffer Sequencing and/or WFA
Kit (4406479) — Glycerol
— 10x Instrument Buffer
— Cleave Solution 1
- Cleave 2 Kit (Cleave 2
Parts 1 and 2)
— Storage Buffer
- Imaging Buffer Kit
(Imaging Buffer Parts 1 and
2)
— 1x T4 Ligase Buffer Kit
(Ligase Buffer Parts 1 and
2)
— 1x Phosphatase Buffer
SOLiD™ Slide Pack Kit Slide Storage Buffer Bead deposition
ezl Sequencing Slides
SOLID™ Bead Deposition Deposition Buffer Bead deposition
Kit (4387895) Overlay Buffer
10 x Terminal Transferase Templated bead
Buffer preparation
10 x Cobalt chloride
Terminal Transferase _g
Bead Linker g
2
S
. . >
Optional Applied
. - i 53]
Biosystems kits ltem (part number) Components Kit comp(i):ent(s) used 2
c
SOLID™ Fragment Library SOLID™ Frag Lib Seq - Fragment sequencing 8
Sequencing — Primer A Primer A Reagents <
Master Mix 50 (4406550) =
SOLID™ Fragment Library SOLID™ Frag Lib Seq - Fragment sequencing g
Sequencing — Primer B Primer B Reagents
Master Mix 50 (4406601)
SOLiD™ Fragment Library SOLID™ Frag Lib Seq - Fragment sequencing
Sequencing — Primer C Primer C Reagents
Master Mix 50 (4406556)
SOLID™ Fragment Library SOLiID™ Frag Lib Seq - Fragment sequencing
Sequencing — Primer D Primer D Reagents
Master Mix 50 (4406559)
SOLiD™ Fragment Library SOLID™ Frag Lib Seq - Fragment sequencing
Sequencing — Primer E Primer E Reagents
Master Mix 50 (4406562)
SOLiID™ Mate-Paired SOLID™MP LibSeq-Tag1 = Mate-pair sequencing
Library Sequencing — Tag 1 Primer A Reagents
Primer A Master Mix 50
(4406565)
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Set up and perform a sequencing run

Required
equipment

Item (part number)

Components

Kit component(s) used
in...

SOLiID™ Mate-Paired
Library Sequencing — Tag 1
Primer B Master Mix 50
(4406568)

SOLiD™ MP Lib Seq - Tag 1
Primer B Reagents

Mate-pair sequencing

SOLiID™ Mate-Paired
Library Sequencing — Tag 1
Primer C Master Mix 50
(4406571)

SOLID™ MP Lib Seq-Tag 1
Primer C Reagents

Mate-pair sequencing

SOLID™ Mate-Paired
Library Sequencing — Tag 1
Primer D Master Mix 50
(4406574)

SOLiID™ Mate-Paired
Library Sequencing — Tag 1
Primer E Master Mix 50
(4406577)

SOLID™ MP Lib Seq - Tag 1
Primer D Reagents

SOLiD™ MP Lib Seq - Tag 1
Primer E Reagents

Mate-pair sequencing

Mate-pair sequencing

SOLiD™ Mate-Paired
Library Sequencing — Tag 2
Primer A Master Mix 50
(4406580)

SOLID™ MP Lib Seq - Tag 2
Primer A Reagents

Mate-pair sequencing

SOLID™ Mate-Paired
Library Sequencing — Tag 2
Primer B Master Mix 50
(4406583)

SOLiID™ Mate-Paired
Library Sequencing — Tag 2
Primer C Master Mix 50
(4406586)

SOLID™ MP Lib Seq - Tag 2
Primer B Reagents

SOLiD™ MP Lib Seq - Tag 2
Primer C Reagents

Mate-pair sequencing

Mate-pair sequencing

SOLiID™ Mate-Paired
Library Sequencing — Tag 2
Primer D Master Mix 50
(4406589)

SOLID™ MP Lib Seq-Tag 2
Primer D Reagents

Mate-pair sequencing

SOLID™ Mate-Paired
Library Sequencing — Tag 2
Primer E Master Mix 50
(4406592)

SOLiD™ Mixing Strip Tube
(4406595)

SOLID™ MP Lib Seq - Tag 2
Primer E Reagents

SOLiD™ Mixing Strip Tubes

Mate-pair sequencing

Fragment or mate-pair
sequencing

ltem#

Source

SOLID™ 3 System

¢ Applied Biosystems
4406205 (110 V)

e Applied Biosystems
4406208 (220 V)

SOLID™ 3 Analyzer

4406207

Applied Biosystems

Upgrade Kit from SOLID™ 2.0 to SOLID™ 3

4409522

Applied Biosystems
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Set up and perform a sequencing run

Item# Source

SOLID™ Light Source Applied Biosystems
4388441

SOLID™ Slide Storage Chamber Applied Biosystems
4406354

SOLID™ Deposition Chambers 1-Well$ Applied Biosystems
4406352

SOLID™ Deposition Chambers 4-Wells$ Applied Biosystems
4406358

SOLID™ Deposition Chambers 8-Wells$ Applied Biosystems
4406359

SOLID™ Slide Carriers$ Applied Biosystems
4406360

SOLID™ Uninterruptible Power Supply (UPS) | ¢ Applied Biosystems
4397781 (SOLID™ UPS North America)
e Applied Biosystems
4393695 (220 V;
SOLID™ UPS International)
SOLID™ Offline Cluster ¢ Applied Biosystems
4413002 (North America)
¢ Applied Biosystems

4425588 (International)
>
SOLID™ Accessory Disk Drive Applied Biosystems =
4426101 %
SOLID™ Bead Concentration Chart Applied Biosystems ;
4415131 c:E
o
Covaris™ S2 System ¢ Applied Biosystems =
4387833 (110 V) 8
(110 V for U.S. customers) ¢ Applied Biosystems §
(220 V for international customers) 4392718 (220 V) %_
or 2

The system includes: Covaris™ Inc.

e Covaris™ S2 sonicator
e Latitude™ laptop from Dell® Inc.
e MultiTemp lll Thermostatic Circulator

e Covaris-2 series Machine Holder for (one)
1.5-mL microcentrifuge tube

e Covaris-2 series Machine Holder for (one)
0.65-mL microcentrifuge tube

e Covaris-2 series Machine Holder for (one)
13 mm x 65 mm tube

For system materials summary, see
“Covaris™ S2 System Materials Summary,”
SOLiID™ 3 System Site Preparation Guide.
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Set up and perform a sequencing run

Required
consumables

ltem#

Source

6-Tube Magnetic Stand

Applied Biosystems
AM10055

Microcentrifuge 5417R, refrigerated, without
rotor

e Eppendorf#

022621807 (120 V/60 Hz)
Eppendorf*
022621840 (230 V/50 Hz)

FA-45-24-11, fixed-angle rotor,
24 x 1.5/2 mL, including aluminum lid,
aerosol-tight

Eppendorf*
022636006

NanoDrop® ND-1000 Spectrophotometer
(computer required)

Thermo Scientific

ND-1000

Scienceware Dry-Keeper AutoDesiccator VWR
Cabinet, Tall# 24983-455
Tabletop Centrifuge (for 96-well plate) MLSH
Vortexer MLS
Picofuge MLS
Magnetic stirrer MLS
Incubator (37 °C) MLS
Refrigerator (4 °C) MLS
Freezer (— 20 °C) MLS
Pipettors, 20 uL MLS
Pipettors, 200 pL MLS
Pipettors, 1000 pL MLS

affect system performance.

T Applied Biosystems has validated this protocol using this specific material. Substitution may adversely

§ The SOLID™ 3 Analyzer is shipped with 2 of each size Deposition Chambers and Slide Carriers. Two Slide

Storage Chambers are provided for use with all chambers.

# Or equivalent but validation of the equipment for library preparation is required.
11 For the MSDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.

Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant

precautions.

ltem#

Source

SOLiD™ Flowcell O-ring. 10-pack

Applied Biosystems

4398217
Nuclease-free water Applied Biosystems
AM9932
ABgene® 96 1.2-mL square-well storage ABgene
e AB-1127

3-mm adhesive disks

Ethylene glycol

Grace Bio-Labs
ST200

American Bioanalytical
AB00455-01000
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Set up and perform a sequencing run

Item# Source
CF-1 Calibration Fluid Kit Thermo Scientific
CF-1
PR-1 Conditioning Kit$ Thermo Scientific
PR-1
1.5-mL LoBind Tubes Eppendorf
022431021
Kimwipes® MLS*
Filtered pipettor tips MLS

1 Applied Biosystems has validated this protocol using this specific material. Substitution may adversely
affect system performance.

§ The NanoDrop® Conditioning Kit is useful for “reconditioning” the sample measurement pedestals to a
hydrophobic state if they become “unconditioned” (see NanoDrop user’s manual for more information).
The PR-1 kit consists of a container of specially formulated polishing compound and a supply of
convenient applicators.

# Forthe MSDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all relevant
precautions.
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Appendix B

Supplemental Procedures

This appendix covers:

B Clean the SOLiD™ Deposition Chamber using a sonicator . ............... 98
B Clean the SOLiD™ Deposition Chamber using Extran 300 . .............. 100
B Install the SOLiD™ Flowcell O-Ring . ............................... 102
B Clean the reagent Strip COVET. . .. v\ v vttt e ee s 103
B Replace the SOLID™ Light Source. . ........vvviieeiieeen .. 104
B Set up a run by importing a Run Definition file. ... .................... 106
B Manually find the focusrange . ........... ... ..., 107
B Shut down the SOLID™ 3 Analyzer ................................. 119
B Reset the robot POSItION .. ... ..ovtvtn e 119
B Store theslideinafloweell........ ... ... .. ... .. ... . ... 119
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Appendix B Supplemental Procedures

Clean the SOLID™ Deposition Chamber using a sonicator

Clean the SOLID™ Deposition Chamber using a sonicator

98

Required
equipment

Required
consumables

Clean the SOLiD™ Deposition Chamber a day before slide deposition with a sonicator
or with Extran 300 (see “Clean the SOLiD"" Deposition Chamber using Extran 300” on

page 100).
Item Source
Sonicator? Branson Ultrasonics, Inc.
8510R-DTH
2-L beaker MLS$

T Applied Biosystems has validated this protocol using this specific material. Substitution may adversely

affect system performance

§ For the MSDS of any chemical not distributed by Applied Biosystems, contact the chemical
manufacturer. Before handling any chemicals, refer to the MSDS provided by the manufacturer, and
observe all relevant precautions.

Item Source
Bleach MLS
Deionized water MLS
Hot water MLS

1. Thoroughly wipe the beaker and the inside of the sonicator with 10% bleach, then
fill the sonicator to the fill line with deionized water. Clean the sonicator and
replace the deionized water every week. Clean the beaker before use.

2. Set the sonicator temperature to 25 °C, then allow it to equilibrate before use.

3. Immediately after the SOLiD Deposition Chamber assembly is disassembled,
thoroughly rinse the SOLiD Deposition Chamber with hot water to remove
residual buffers from previous deposition. Rinse the base of the chamber with
deionized water and allow it to dry overnight.

4. Degas the sonicator for 5 minutes before use.

5. Place the SOLiID Deposition Chamber and SOLiD"™ Slide Carrier into the beaker.
Place the beaker in the sonicator, then sonicate the SOLiD Deposition Chamber
and the SOLiD Slide Carrier for 10 minutes.
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6. After sonication, remove the SOLiD Deposition Chamber and SOLiD Slide
Carrier from the sonicator, then rinse the SOLiD Deposition Chamber and SOLiD
Slide Carrier thoroughly with deionized water (3 to 5 minutes for each chamber).
When rinsing the chamber, be careful with the face and O-ring that come into
contact with the slide.

@ IMPORTANT! Do not use abrasive chemicals or wipes, because they can
damage the chamber and gasket.

7. Dry the SOLiD Deposition Chamber and SOLiD Slide Carrier overnight or at
37 °C for 1 hour before use.

>
©
©
(0]
>
o
X
@
(92}
c
e}
S
(0]
3
@
>
=4
o
Y
o
(@}
[0
o
c
=
[0
(7]

SOLID™ 3 System Instrument Operation Guide 99



Appendix B Supplemental Procedures
Clean the SOLID™ Deposition Chamber using Extran 300

Clean the SOLID™ Deposition Chamber using Extran 300

Clean the SOLiD™ Deposition Chamber a day before slide deposition with Extran 300
or with a sonicator (see “Clean the SOLiD™ Deposition Chamber using a sonicator” on

page 98).
Required
equipment
Item Source
Tub MLS*
Pipette or graduated cylinder MLS
T For the MSDS of any chemical not distributed by Applied Biosystems, contact the chemical
manufacturer. Before handling any chemicals, refer to the MSDS provided by the manufacturer, and
observe all relevant precautions.
Required
consumables
Item Source
Extran 300 VWR
EM-EX0996-2
Deionized water MLS
Hot water MLS

1. Prepare enough 1:1000 dilution of Extran 300 and deionized water to fill a large
tub suitable for washing SOLiD"™ Deposition Chambers, leaving enough empty
volume in the tub for the addition of the SOLiD Deposition Chambers (for
example, 5 mL of Extran 300 in 4995 mL deionized water for a 7-L tub).

2. Immediately after the SOLiD Deposition Chamber assembly is disassembled,
thoroughly rinse the SOLiD Deposition Chamber assembly with hot water,
removing residual buffers from the previous deposition. Rinse the base of the
chamber with deionized water and allow it to dry overnight.

3. Place the SOLiD Deposition Chamber and SOLiD™ Slide Carrier into the tub to
soak for 5 minutes.

4. Gently agitate the tub for 2 minutes. Be careful not to let the face of the SOLiD
Deposition Chamber rub against the tub or other SOLiD Deposition Chambers.

5. Allow the SOLiD Deposition Chamber and SOLiD Slide Carrier to soak for
another 5 minutes.
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6. After the second soak, remove the SOLiD Deposition Chamber and SOLiD Slide
Carrier from the tub and rinse thoroughly with deionized water (3 to 5 minutes for
each chamber). When rinsing the chamber, be careful with the face and O-ring
that come into contact with the slide.

@ IMPORTANT! Do not use abrasive chemicals or wipes, because they can
damage the chamber and gasket.

7. Dry the SOLiD Deposition Chamber and SOLiD Slide Carrier overnight before
use.
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Install the SOLID™ Flowcell O-Ring

102

After each run, check the SOLiD"™ Flowcell O-ring for cuts and abrasions. If you see
any abnormalities, replace the O-ring. Inspect the O-ring groove for debris or
contamination. Clean the O-ring groove with water as needed.

Required
equipment Item Source
SOLiID™ Flowcell O-ring, 10-pack Applied Biosystems
4398217

Procedure 1. Insert the O-ring into the groove on the flowcell so that the smooth side is on top
(see Figure 67).

2. Run your finger around the O-ring to make sure that there are no high spots.

Figure 67 Install the SOLID™ O-Ring on a flowcell.
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Clean the reagent strip cover

Inspect the top and bottom of the reagent strip covers after each run for splattered wet
or dry reagents. If you see reagent on a cover, clean the cover (see Table 15).

Required
equipment Item Source
Pipette or graduated cylinder MLS#
Scrub brush MLS
T For the MSDS of any chemical not distributed by Applied Biosystems, contact the chemical
manufacturer. Before handling any chemicals, refer to the MSDS provided by the manufacturer, and
observe all relevant precautions.
Required
consumables
Item Source
Extran 300 VWR
EM-EX0996-2
Kimwipes® MLS
Deionized water MLS
Cotton swabs MLS

Table 15 Clean the reagent strip cover according to location or amount of
reagent splatter

If you see... Then

Minor splashes Wipe the reagent strip cover with a
Kimwipe®. If the reagents are dried, first wet
the Kimwipe moistened with deionized water
or a dilution of Extran 300 wash detergent in
deionized water

Reagents in the holes of the of the reagent Wipe the inside surfaces of the holes with a
strip cover cotton swab. If the reagents are dried, first
wet the cotton swab as necessary with
deionized water or a dilution of Extran 300
wash detergent in deionized water.

Large areas of dried reagents Wash the covers in a dilution of Extran wash
detergent (10 mL Extran 300 in 1 L of
deionized water). If needed, use a scrub
brush.
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Replace the SOLID™ Light Source

WARNING! PHYSICAL INJURY HAZARD. Hot Surface. Surface of the
SOLiD"™ Light Source may be hot. Use care when working around the
SOLiD Light Source to avoid being burned.

$i)

Replace the SOLiD™ Light Source in the SOLiD™ 3 Analyzer every 1500 hours.

Required
equipment Item Source
SOLID™ Light Source Applied Biosystems
4388441

1. Under the System Status menu on the ICS, click the Turn Off button for the lamp
(see Figure 68).

I L= Yo P T o s, i

mmmran = . v P it W

Figure 68 Lamp controls in the ICS.

2. Let the lamp cool for at least 15 minutes.

3. Unscrew the 4 screws retaining the light box access cover on the top of the
instrument.

4. Remove the cover to the light source from the housing.
5. Pull the light source straight up and out of unit.

6. Slide a new SOLiD™ Light Source into place. Ensure that the light source is
oriented in the correct direction (see Figure 69 on page 105).
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7. Refit and screw down the access cover to the housing.
8. Restart power to the SOLiD Light Source.

9. In the System Status menu on the ICS, click Reset to reset the lamp timer.

Figure 69 Orientation of the SOLID™ Light Source.
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Set up a run by importing a Run Definition file

A sequencing run can be set up by importing a Run Definition file that has been
created offline. Setting up a run by importing a run definition file saves time re-
entering information of a repeated run.

1. Acquire a template Run Definition file. The most reliable way of acquiring the
file is to create a run using the Run Wizard, assign it to the database, then select
Export Run from the Manage Runs window.

2. Create a Run Definition with the information appropriate to your run. Save the
file as a .txt file.

3. Click Manage Runs, select Import Run, then select the Run Definition file.

4. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.
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Manually find the focus range

You should first attempt automatic range detection (see “Detect the focus range” on
page 44). If automatic detection fails, then use the manual mode.

Select the flowcell, 1. Close the front doors of the SOLiD™ 3 Analyzer. Open the Imager window by
then find the beads choosing Window » Imaging System.
on the slide

2. Select the Show Flowcell box in the bottom left hand corner of the Imager
window, then choose the number of the flowcell to set (Flowcell 1 or Flowcell 2;
see Figure 70).
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Figure 70 Click Show Flowcell to find the beads on the slide.

3. From the View menu, choose Stage Template, then navigate to the C:\Runs
directory. Find the folder in the Runs directory that corresponds to the run just set
up, then choose the .STG file for the run. Choosing Stage Template and the .STG
file superimposes the slide layout on the Imager screen.

4. Use the mouse to drag the green-box cursor to a position on the upper-left side of
the slide. Dragging the green-box cursor moves the flowcell stage to that corner of
the slide (see Figure 71 on page 108).
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Figure 71 Use the mouse to drag the green-box cursor and to move the flowcell
stage the same way.

Find the focal range 1. Set the Filter Status to WL (white light; see Figure 72).
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Figure 72 Click WL (white light) to set the Filter Status.
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2. Inthe Imager window, click the AutoFocus button, then wait about 20 seconds for
the Imager to focus on the slide (see Figure 73). The Camera 1 indicator displays
BUSY while autofocus is running. When the Camera 1 indicator displays READY,
click AutoExpose, then wait for the Camera 1 indicator to show READY. Click
AutoFocus so that the Imager can focus again (this time with correct exposure
settings). Note where the focus peak falls in the focus range by looking at the
value that displays where the peak is located.
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Figure 73 Click AutoFocus and AutoExpose so that the focus peak falls in the
focus range.

3. When the Imager displays READY, click the Acquire button, then examine the
image on the screen (see Figure 74 on page 110).
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Image in focus Image out of focus

Figure 74 Examine the image on the screen.

‘\; Note: To zoom on the image, double-left-click the mouse. To un-zoom,
double-right-click. To drag the image, hold down the left mouse button.

4. If the image is in focus, proceed to “Calculate, then set the focal range” on
page 114. If the image is out of focus, proceed to step 5.

5. Check the Go Live check box in the Imager window. By checking the Go Live

check box, a live image of the flowcell displays. You can use this image to
manually find the focal range (see Figure 75 on page 111).
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Appendix B Supplemental Procedures
Manually find the focus range
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Figure 75 Check Go Live to manually find the focal range.

6. Click the focus slider bar in the Imager window. A black box appears (see
Figure 76 on page 112).

SOLID™ 3 System Instrument Operation Guide
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Figure 76 Use the black box to change the focal distance.

7. When the black box is visible, hold down the Ctrl key and hold down either the
right or left arrow key on the keyboard. Holding down Ctrl and the arrow key
(right or left arrow) simultaneously changes the focal distance in 300-count
intervals.

8. While watching the live image on the screen, scan the focal distance:

* Use the Ctrltright arrow keys to scan the focal distance upward. When the
live image is in focus, release the keys, then record the value shown in the
black box of the Imager window.

» If an in-focus image cannot be found, then scan downward using the
Ctrl+left arrow keys, past the starting point, while watching the live image
on the screen. When the live image is in focus, release the keys, then record
the value shown in the black box of the Imager window.

The value in the black box of the imager window when the image is in focus is the
nominal Z distance.

For examples of in-focus images, see Figure 77 on page 113.
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Figure 77 Examples of in-focus images.

9. Uncheck the Go Live check box in the Imager window to close the live-image
window.
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Calculate, then set 1. When the image is in focus, record the value of the Z distance in the Focus Status
the focal range pane. This is the nominal Z distance for this flowcell. Be sure to record the correct
Z distance value, not the value in the GoTo window (see Figure 78).
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Figure 78 Record the nominal Z distance.

2. Choose Options » Focusing.

3. Ensure that Do auto-exposure with auto-focus is checked. Enter a value 5000
less than the nominal Z distance for Z Min. Enter a value 5000 greater than the
nominal Z distance for Z Max. Enter 30 for the Number of Steps and choose
Histogram Range from the drop-down menu in the Focusing Method Selection
pane (see Figure 79 on page 115).

IMPORTANT! Leave the Auto-Focus Options window opern on the Desktop.

Do not click the Save to File button. Values entered in the Focusing box are
used by the Imager software even if the values are not saved.
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L Auto-Focus Options : :|[z|

Focusz Settings

Outzide
Flowcell:
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Saved Saved Saved

Flaweel 1 Floweell 2
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File File File

Murmber of Steps: |30

[v Do auto-exposure with auto-focus

Focusing Method Selection

| Histogram Fange j

Figure 79 Enter auto-focus options.
4. Use the mouse to move the green box to the upper-left corner of the slide.

5. In the Imager window, click the Autofocus button, then wait about 20 seconds for
the Imager to focus on the slide. The Camera 1 indicator displays BUSY while the
autofocus is running. When the Camera 1 indicator displays READY, click
AutoExpose and wait for the Camera 1 indicator to display READY. Click
AutoFocus so that the Imager can focus again (this time with the correct exposure
settings).

6. When the Imager displays READY, click the Acquire button, then confirm that
the image is in focus.

7. Record the Z distance value from the Focus Status pane (see Figure 80 on
page 116).
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Figure 80 Record the Z distance value.

8. Open Notepad, then record the measured focal value for the spot on the slide that

has been focussed.

9. Repeat steps 4 to 8 for the top right, bottom left, bottom right, and center of the
slide. The range of these values should not exceed 5000 units. Calculate the
average value of the highest and lowest spots and record this value in Notepad (see

Figure 81 on page 117).

IMPORTANT! If the range of these values exceeds 5000 units, the flowcell
is out of alignment. Call your Applied Biosystems Field Service Engineer

to align the flowcell.
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[P untitled - Notepad B [=]
File Edit Format Wiew Help

653830 a
853930 _I
548700
6459250
651550

highest = 653930
Towest = 648750
average of highest and Towest = 631360

set range +/- 5000
range = 646360 - 536360

4] 2

Figure 81 Record the average focal value in Notepad.

10. Subtract 5000 counts from the calculated average, then enter that value in the Z
Min box. Add 5000 counts to the average, then enter that value into the Z Max
box. Confirm that the Number of Steps is 30. Click Save to File (see Figure 82).

M Auto-Focus Options

Focuz Settings

Outzide
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v Do auto-esposure with auto-focus

Focuzing Method Selection
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Figure 82 Enter the focus settings.

11. Click Yes when the warning displays (see Figure 83 on page 118).
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v Confirm Save Focus Range @

\p Save Z min and max for flowcell 2 to file?

T | T

Figure 83 Click Yes when the Save Focus Range Warning displays.

12. When the Flowcell Selection window displays, choose the number of the flowcell
(1 or 2) that has just been measured and click OK. The focal range is saved.

13. (Optional) Repeat all previous steps starting from “Select the flowcell, then find
the beads on the slide” on page 107.
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Shut down the SOLIiD™ 3 Analyzer

The instrument can be shut down using the Instrument Shutdown wizard in the ICS.
For instruments that have UPS, in the event of power failure, an uninterrupted power
supply (UPS) is activated, UPS systematically shuts down the instrument: Analysis
jobs are stopped and Linux is shut down. Slides are preserved in Storage Buffer.

Required
equipment Item Source
UPS Applied Biosystems
4397781 (North America)
4393695 (International)

1. Open the Instrument Shutdown wizard by choosing Wizards » Instrument
Shutdown.

2. Follow the instructions in the wizard.

Reset the robot position

The Robot standby script sends the robot back to home position.
1. Open the Utility Scripts menu by choosing Tools » Utility Scripts.
2. Select Robot standby.

3. Select Run Script.

Store the slide in a flowcell

The Store flowcell script fills the flowcell with Storage Buffer.
1. Open the Utility Scripts menu by choosing Tools » Utility Scripts.
2. Select Store flowcell.

3. Select Run Script.
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C On-Instrument Reagent Volumes and
Reagent Strip Layouts

This appendix covers:

B Recommended fill volumes for on-instrument reagents. . . ............... 122
Fragment sequencing (50bp) .. ...t 122
Mate-pair sequencing (250r50bp) .. ... 122
Barcode sequencing (S5bp) .. ..o ottt 123
Workflow analysis (WFA). .. ... ... e 123

B Reagentstriplayouts. ... ...t 124
Fragment seqUencCing ... ...ttt 124
Mate Pair Tag 1 sSeqUeNCINg . ... ..ottt ettt 125
Mate Pair Tag 2 SEqUENCING . . . ..ottt et e 126
Barcode sequencing . ...........o i 127
Workflow analysis (WFA). .. ... . o e 128
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Recommended fill volumes for on-instrument reagents

Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts

Recommended fill volumes for on-instrument reagents

_Fragment  Table 16 Fill volumes for fragment sequencing (50 bp)
sequencing (50 bp)

Volume (mL)
1 Flowcell 2 Flowcells

Instrument Buffer 2949 5710
Storage Buffer 422 746
Cleave 1 Solution 167 311
Cleave 2 Solution 167 311
Reset Buffer 91 163
Ligase Buffer 60 110
Phosphatase Buffer 36 62
Imaging Buffer 110 196

Mate-pair Table 17 Fill volumes for mate-pair sequencing (25 or 50 bp)

sequencing
(25 or 50 bp) Volume per tag (mL)
25 bp 50 bp
1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells

Instrument Buffer 1629 3069 2949 5710
Storage Buffer 289 479 422 746
Cleave 1 Solution 92 161 167 311
Cleave 2 Solution 92 161 167 311
Reset Buffer 91 163 91 163
Ligase Buffer 35 59 60 110
Phosphatase Buffer 23 35 36 62
Imaging Buffer 67 111 110 196
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Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts
Recommended fill volumes for on-instrument reagents

Barcode Table 18 Fill volumes for barcode sequencing (5 bp)

sequencing (5 bp)

Volume (mL)

(WFA)

1 Flowcell 2 Flowcells
Instrument Buffer 638 1088
Storage Buffer 189 279
Cleave 1 Solution 32 41
Cleave 2 Solution 32 41
Reset Buffer 91 163
Ligase Buffer 16 21
Phosphatase Buffer 13 15
Imaging Buffer 33 43
Workflow analysis  Table 19 Fill volumes for workflow analysis (WFA)
Volume (mL)
1 Flowcell 2 Flowcells
Instrument Buffer 294 400
Storage Buffer 116 134
Cleave 1 Solution 0 0
Cleave 2 Solution 0 0
Reset Buffer 43 67
Ligase Buffer 12 12
Phosphatase Buffer 0 0
Imaging Buffer 26 30

SOLID™ 3 System Instrument Operation Guide
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C Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts
Reagent strip layouts

Reagent strip layouts

Fragment
sequencing

S0LID™ Frag Lib Seq -
Primer E Raapants

SOLID™ Frag Lib Seq —
Primer D Reagenis

SOLID™ Frag Lib Seq -
Primer C Reagents

S0LID™ Frag Lib Seq -
Primar B Raagents

SOLID™ Frag Lib Seq -
Primar A Reagents
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Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts
Reagent strip layouts

Mate Pair Tag 1
sequencing

SOLID™ MP Lib Seq -
Tag 1 Primer E Reagants

SOLID™ MP Lib Seq—
Tag 1 Primer D Reagents

SOLID™ MP Lib Seq -
Tag 1 Primer C Reagenis
SOLID™ MP Lib Seq -
Tag 1 Primar B Reagents

SOLID™ MP Lib Seq -
Tag 1 Primar A Reagents
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C Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts
Reagent strip layouts

Mate Pair Tag 2
sequencing

SOLID™ MP Lib Seq -
Tag 2 Primer E Reagents

SOLID™ MP Lib Seq —
Tag 2 Primer D Reagenls

SOLID™ MP Lib Seq -
Tag 2 Primer C Reagents

SOLID™ MP Lib Seq -
Tag 2 Primar B Raagents

SOLID™ MP Lib Seq -
Tag 2 Primar A Reagents
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Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts
Reagent strip layouts

Barcode
sequencing

S0LID™ Frag Lib Saq -
BC Erldge Probes Rgnts

S0LID™ Frag Lib Seq -
| BC Primers Reagants
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C Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts
Reagent strip layouts

Workflow analysis
(WFA)

S0UD™ Workflow

Analysis Reaganis
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Appendix D

Instrument Process Times

This appendix covers:
B Times for individual processes . . ...t 130

B Times fOr entire PrOCESSES . . v v vt vt vttt et e e e e e e e e e 130
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Appendix D Instrument Process Times
Times for individual processes

Times for individual processes

Table 20 Times for individual processes

Process

Estimated Time (h)

Steps

Estimated time per

primer (h)

Focal Map ~21t03 Reset
P2 Label
Image

Sequencing Primers 1 & ~3to4 Reset ~3to4

2 and Ligation Prime (1 cycle or 5 bp)
Ligate ~15t0 17
Dark Ligate (5 cycles or 25 bp)
Phosphatase ~28t0 33
Image (10 cycles or 50 bp)
Cleave

Sequencing Primers 3, ~4t05 Reset ~4t05

&, 619 el e Prime (1 cycle or 5 bp)
Bridge Probe ~16to 18
Ligate (5 cycles or 25 bp)
Dark Ligate ~29to 34
Phosphatase (10 cycles or 50 bp)
Image
Cleave

Ligation cycle ~2.51t03 Ligate

(without priming) Dark Ligate
Phosphatase
Image
Cleave

Times for entire processes
Table 21 Times for entire processes
Process Total Runtime#

Workflow Analysis (WFA) ~4 to 5 hours

Fragment (50 bp) ~6 to 7 days

Mate Pair (2 x 25 bp) ~7 to 8 days

Mate Pair (2 x 50 bp)
Barcode (5 bp)

~13 to 14 days
~1 day

I The estimated time is for a dual slide run. Estimated times may vary due to differences in imaging time.

130
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Appendix E

E SOLID™ 3 Analyzer Plumbing System

Schematic
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Appendix E SOLID™ 3 Analyzer Plumbing System Schematic
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Appendix F

I: Checklists and workflow tracking forms

This appendix covers:

B Workflow checklists: set up a workflow analysis or sequencingrun .. ...... 134
B Workflow tracking: set up and perform a workflow analysis (WFA) run. . . .. 135
B Workflow tracking: set up a sequencing run (1-well).................... 136
B Workflow tracking: set up a sequencing run (4-well). . .................. 137
B Workflow tracking: set up a sequencing run (8-well).................... 138
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Workflow checklists: set up a workflow analysis or sequencing

run

134

Appendix F Checklists and workflow tracking forms
Workflow checklists: set up a workflow analysis or sequencing run

Equipment Reagents Preparation Steps
O Covaris™ S2 System O 1XTEX Buffer O Clean anddrythe
) O SOLID™Bead O Deposition Buffer SOLID™ Deposition
s Concentration Chart O Double distilled filtered Chamber overnight
s O SOLID™ Deposition water
2 Chamber O 1.5-mL LoBind tubes
= O SOLID™Slide Carrier O 3-mm adhesive disks
8 O NanoDrop™ ND-1000 O Filtered pipettor tips
g O 6Tube magnetic rack
a O Incubator (37 °C)
[0 Pipettors
O SOLID™ 3 Analyzer O 10x Instrument Buffer
* O 8-Lreagent bottle O Storage Buffer
c O Graduated cylinder O 1x T4 DNA Ligase Buffer
S O Magnetic stir bar (Parts 1 and 2)
g O Pipettors O Phosphatase Buffer
=% O Imaging Buffer (Parts 1
7o and 2)
£ S O Cleave Solution 1
= O Cleave Solution 2
g (Parts 1 and 2)
S O Reset Buffer
O Glycerol
O Double-distilled water
O SOLID™ 3 Analyzer O Deposition Buffer
=z O Pipettors O Overlay Buffer
8 O Allen wrench O Filtered pipettor tips
= O SOLID™ Slide Storage O 70% ethandl
= Chamber (optional) O Kimwipes®
2 O Slide Storage Buffer
£ (optional)
O Tabletop centrifuge O 96-well square-well O Thaw appropriate reagent
= ‘é 0D storage plate strip(s)
goe
£90%
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Appendix F Checklists and workflow tracking forms
Workflow tracking: set up and perform a workflow analysis (WFA) run

Workflow tracking: set up and perform a workflow analysis (WFA) run

Slide: Date:

Run: Date:

Sample Name

Sample information (pre-WFA)

AB00
Concentration
(beads/pL)
Deposition Volume
(©L)

WFA report

P2_rfu
P2_Exp

P2_Gain

P1#

P2#

P2#/P1# ratio

N2S

On Axis

Titration Metric

Sample information (post-WFA)

P2 Concentration
(beads/pL)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer
Overlay Buffer
Instrument Buffer
Storage Buffer

T4 Ligase Buffer Part 1
T4 Ligase Buffer Part 2
Phosphatase Buffer
Imaging Buffer Part 1
Imaging Buffer Part 2
Cleave Solution 1
Cleave Solution 2 Part 1
Cleave Solution 2 Part 2
Reset Buffer

Slide Storage Buffer
Workflow Analysis
Reagents
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Appendix F Checklists and workflow tracking forms
Workflow tracking: set up a sequencing run (1-well)

Workflow tracking: set up a sequencing run (1-well)

136

Slide:

Date:

Run:

Date:

Sample Name

Sample information

AGO0

Concentration
(beads/pL)

Deposition Volume
(uL)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer

Overlay Buffer

Instrument Buffer

Storage Buffer

T4 Ligase Buffer Part 1

T4 Ligase Buffer Part 2

Phosphatase Buffer

Imaging Buffer Part 1

Imaging Buffer Part 2

Cleave Solution 1

Cleave Solution 2 Part 1

Cleave Solution 2 Part 2

Reset Buffer

Slide Storage Buffer

Fragment Library Seq Kit

Frag Lib Seq — Primer A

Frag Lib Seq — Primer B

Frag Lib Seq — Primer C

Frag Lib Seq — Primer D

Frag Lib Seq — Primer E

Mate-Paired Library Seq Kit

MP Lib Seq- Tag 1 Primer A

MP Lib Seq- Tag 1 Primer B

MP Lib Seq- Tag 1 Primer C

MP Lib Seq- Tag 1 Primer D

MP Lib Seq- Tag 1 Primer E

MP Lib Seq - Tag 2 Primer A

MP Lib Seq - Tag 2 Primer B

MP Lib Seq- Tag 2 Primer C

MP Lib Seq- Tag 2 Primer D

MP Lib Seq- Tag 2 Primer E

Frag Barcode Library Seq Kit

BC Lib Seq — BC Probe

BC Lib Seq — BC Primers

BC Lib Seq - BC Bridge
Probes
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Appendix F Checklists and workflow tracking forms
Workflow tracking: set up a sequencing run (4-well)

Workflow tracking: set up a sequencing run (4-well)

Slide: Date:

Run: Date:

Samples 1 to 4

Sample Name

Sample information

AG00

Concentration
(beads/pL)
Deposition Volume
(WD)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer

Overlay Buffer

Instrument Buffer

Storage Buffer

T4 Ligase Buffer Part 1

T4 Ligase Buffer Part 2
Phosphatase Buffer

Imaging Buffer Part 1
Imaging Buffer Part 2

Cleave Solution 1

Cleave Solution 2 Part 1
Cleave Solution 2 Part 2
Reset Buffer

Slide Storage Buffer
Fragment Library Seq Kit
Frag Lib Seq — Primer A

Frag Lib Seq — Primer B

Frag Lib Seq — Primer C

Frag Lib Seq — Primer D

Frag Lib Seq - Primer E
Mate-Paired Library Seq Kit
MP Lib Seq- Tag 1 Primer A
MP Lib Seq- Tag 1 Primer B
MP Lib Seq- Tag 1 Primer C
MP Lib Seq - Tag 1 Primer D
MP Lib Seq- Tag 1 Primer E
MP Lib Seq- Tag 2 Primer A
MP Lib Seq- Tag 2 Primer B
MP Lib Seq- Tag 2 Primer C
MP Lib Seq - Tag 2 Primer D
MP Lib Seq - Tag 2 Primer E
Frag Barcode Library Seq Kit
BC Lib Seq — BC Probe

BC Lib Seq - BC Primers
BC Lib Seq - BC Bridge
Probes
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Appendix F Checklists and workflow tracking forms
Workflow tracking: set up a sequencing run (8-well)

Workflow tracking: set up a sequencing run (8-well)

138

Slide:

Date:

Run:

Date:

Samples 1 to 4

Sample Name

Sample Information

AG00

Concentration (beads/ul)

Deposition Volume (uL)

Volume Left
Beads Left
Samples 5 to 8
Sample Name
Sample information
A600

Concentration (beads/ul)

Deposition Volume (uL)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer

Overlay Buffer

Instrument Buffer

Storage Buffer

Ligase Buffer

Phosphatase Buffer

Imaging Buffer Part 1

Imaging Buffer Part 2

Cleave Solution 1

Cleave Solution 2 Part 1

Cleave Solution 2 Part 2

Reset Buffer

Slide Storage Buffer

Fragment Library Seq Kit

Frag Lib Seq — Primer A

Frag Lib Seq — Primer B

Frag Lib Seq — Primer C

Frag Lib Seq — Primer D

Frag Lib Seq — Primer E

Mate-Paired Library Seq Kit

MP Lib Seq- Tag 1 Primer A

MP Lib Seq- Tag 1 Primer B

MP Lib Seq- Tag 1 Primer C

MP Lib Seq- Tag 1 Primer D

MP Lib Seq- Tag 1 Primer E

MP Lib Seq- Tag 2 Primer A

MP Lib Seq- Tag 2 Primer B

MP Lib Seq- Tag 2 Primer C

MP Lib Seq- Tag 2 Primer D

MP Lib Seq- Tag 2 Primer E

Frag Barcode Library Seq Kit

BC Lib Seq - BC Probe

BC Lib Seq — BC Primers

BC Lib Seq — BC Bridge Probes
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Appendix G

The Covaris™" S2 System

This appendix covers:

B OpPeration NOES . . o\ v et ettt et e e e et e e 140
Fillthetank. .. ... ... 140
Degasthe water. .. ...t 140
Setthechiller ...... ... .. 140
Perform required maintenance of the Covaris’ S2 System ............... 140

B Covaris™ S2 PrOgrams . ... ..........ouuuemm 140
Covalent Declump 1 ... ... e 140
Covalent Declump 3 . ... ... 141
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G Appendix G The Covaris ™ S2 System
Operation notes

Operation notes

Fill the tank

Degas the water

Set the chiller

Perform required
maintenance of the
Covaris™ S2
System

Fill the tank with fresh deionized water to the proper fill line. The water should cover
the visible part of the tube.

Degas the water for 30 minutes. To maintain degassed water, keep the pump
continuously on during operation and sample processing.

Set the chiller temperature to between 2 to 5 °C to ensure that the temperature reading
in the water bath displays 5 °C. The circulated water chiller should be supplemented
with 20% ethylene glycol.

The Covaris S2 System requires regular maintenance to work properly. Perform the
tasks in the table below (see Table 22):

Table 22 Required maintenance of the Covaris™ S2 System

Required maintenance task Frequency to perform task
Degas water for 30 minutes prior to use Before every use
Change water Daily
Clean with bleach Every two weeks

Covaris™ S2 Programs

Covalent
Declump 1

140

Table 23 Covalent Declump 1: 1 cycle Treatment 1 followed by 1 cycle
Treatment 2

Treatment 1 Treatment 2
Duty Cycle 2% 5%
Intensity 6 9
Cycles/Burst 100 100
Time 5 sec 30 sec
Target wattage power 4 15
performance estimate (W)*

I Not programmed.

SOLID™ 3 System Instrument Operation Guide



Covalent

Appendix G The Covaris ™ S2 System
Covaris™ S2 Programs

Declump 3 Table 24 Covalent Declump 3: 3 cycles Treatment 1 followed by 1 cycle

Treatment 2

Treatment 1

Treatment 2

Duty Cycle 2% 5%
Intensity 6 9
Cycles/Burst 100 100
Time 5 sec 30 sec
Target wattage power 4 15

performance estimate (W)*

I Not programmed.

SOLID™ 3 System Instrument Operation Guide
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G Appendix G The Covaris ™ S2 System
Covaris™ S2 Programs
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Appendix H

Instrument Warranty Information

This appendix covers:

B Computer configuration . ..............vtitirntnrennnnennn.. 144
B Limited product warranty . . .. ........c.vrit et 144
B Warranty period effectivedate .. ............ ... ... .. .. .. .. .. ... 145
B Warranty claims .. ... i 145
B Warranty eXCePLIONS . . .. v\ v v vttt et ettt e e 145
B Warranty imitations . . .. ...ttt 146
B Damages, claims, and returns. . . ...ttt 147
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Appendix H Instrument Warranty Information
Computer configuration

Computer configuration

Applied Biosystems supplies or recommends certain configurations of computer
hardware, software, and peripherals for use with its instrumentation. Applied
Biosystems reserves the right to decline support for or impose extra charges for
supporting nonstandard computer configurations or components that have not been
supplied or recommended by Applied Biosystems. Applied Biosystems also reserves
the right to require that computer hardware and software be restored to the standard
configuration prior to providing service or technical support. For systems that have
built-in computers or processing units, installing unauthorized hardware or software
may void the Warranty or Service Plan.

Limited product warranty

144

Applied Biosystems warrants that all standard components of the SOLiD™ 3 Analyzer,
IKA® ULTRA-TURRAX® Tube Drive, the Covaris” S2 System, APC UPS, and the
recirculating chiller will be free of defects in materials and workmanship for a period
of one (1) year from the date the warranty period begins. Applied Biosystems will
repair or replace, at its discretion, all defective components during this warranty
period. Applied Biosystems warrants the Genomic Solutions Hydroshear will be free
of defects in materials and workmanship for a period of one (1) year from the date the
warranty period begins. Applied Biosystems will replace a defective Hydroshear
during the warranty period. The following parts of the Hydroshear are use- replaceable
and not covered by the warranty on the Hydroshear: shearing assembly, syringes,
syringe adapters, syringe shields, and output tubing. Applied Biosystems reserves the
right to use new, repaired, or refurbished instruments or components for warranty and
post-warranty service agreement replacements. Repair or replacement of products or
components that are under warranty does not extend the original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its SOLiD 3
Analyzer, such as peripherals, printers, and special monitors, will be free of defects in
materials and workmanship for a period of ninety (90) days from the date the warranty
begins. Applied Biosystems will repair or replace, at its discretion, defective
accessories during this warranty period. After this warranty period, Applied
Biosystems will pass on to the buyer, to the extent that it is permitted to do so, the
warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or
components used on or in the instrument are themselves warranted to be free of defects
in materials and workmanship for a period of ninety (90) days.

Applied Biosystems warrants that chemicals and other consumable products will be
free of defects in materials and workmanship when received by the buyer, but not
thereafter, unless otherwise specified in documentation accompanying the product.
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Appendix H Instrument Warranty Information
Warranty period effective date

Applied Biosystems warrants that for a period of ninety (90) days from the date the
warranty period begins, the tapes, diskettes, or other media bearing the operating
software of the product, if any, will be free of defects in materials and workmanship
under normal use. If there is a defect in the media covered by the above warranty and
the media is returned to Applied Biosystems within the ninety (90) day warranty
period, Applied Biosystems will replace the defective media.

Unless indicated herein, Applied Biosystems makes no warranty whatsoever in regard
to products or parts furnished by third parties, including but not limited to the non-
APC- branded UPS or APC UPS, Covaris S2, Genomic Solutions Hydroshear,
Recirculating Chiller, and IKA ULTRA-TURRAX purchased or obtained from a third
party. Such products or parts will be subject to the warranties, if any, of their respective
manufacturers to the extent they are ‘transferable or otherwise available to Applied
Biosystems' buyer.

Applied Biosystems at its sole discretion may refuse to provide buyer with support or
service for buyer's use of Covaris S2 in a method not described in a SOLiD System
protocol.

Applied Biosystems does not warrant that the operation of the instrument or its
operating software will be uninterrupted or be error-free.

Warranty period effective date

Any applicable warranty period under these sections begins on the earlier of the date of
installation or ninety (90) days from the date of shipment for hardware and software
installed by Applied Biosystems personnel. For all hardware and software installed by
the buyer or anyone other than Applied Biosystems, and for all other products, the
applicable warranty period begins the date the product is delivered to the buyer.

Warranty claims

Warranty claims must be made within the applicable warranty period, or, for chemicals
or other consumable products, within thirty (30) days after receipt by the buyer unless
otherwise specified in the documentation accompanying the product.

Warranty exceptions

uolBWIOU|

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation with incompatible solvents or samples
in the system; operation outside of the environmental or use specifications or not in
conformance with the instructions for the instrument system, software, or accessories;
improper or inadequate maintenance by the user; installation of software or interfacing,
or use in combination with software or products, not supplied or authorized by Applied
Biosystems; modification or repair of the product not authorized by Applied
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Appendix H Instrument Warranty Information

Warranty limitations

Biosystems; relocation or movement of the instrument by buyer or by any third party
not acting on behalf of Applied Biosystems; or intrusive activity, including without
limitation, computer viruses, hackers or other unauthorized interactions with
instrument or software that detrimentally affects normal operations.

Parts in contact with any liquid are considered wetted and may be deemed user-
replaceable and not be covered by the above warranties, including, but not limited to,
seals, filters, gaskets, shearing assemblies, valves, syringes, syringe adapters, syringe
shields, and output tubing.

Warranty limitations

146

THE FOREGOING PROVISIONS SET FORTH APPLIED BIOSYSTEMS' SOLE
AND EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND OBLIGATIONS
WITH RESPECT TO THE PRODUCTS WARRANTIED HEREIN, AND APPLIED
BIOSYSTEMS MAKES NO OTHER WARRANTY OF ANY KIND
WHATSOEVER, EXPRESSED OR IMPLIED, INCLUDING WITHOUT
LIMITATION, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, WHETHER ARISING FROM A STATUTE OR
OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE OF
TRADE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S SOLE AND
EXCLUSIVE REMEDIES. WITHOUT LIMITING THE GENERALITY OF THE
FOREGOING, TO THE FULL EXTENT ALLOWED BY LAW, IN NO EVENT
SHALL APPLIED BIOSYSTEMS BE LIABLE, WHETHER IN CONTRACT, TORT,
WARRANTY, OR UNDER ANY STATUTE (INCLUDING WITHOUT
LIMITATION, ANY TRADE PRACTICE, UNFAIR COMPETITION, OR OTHER
STATUTE OF SIMILAR IMPORT) OR ON ANY OTHER BASIS, FOR DIRECT,
INDIRECT, PUNITIVE, INCIDENTAL, MULTIPLE, CONSEQUENTIAL, OR
SPECIAL DAMAGES SUSTAINED BY THE BUYER OR ANY OTHER PERSON
OR ENTITY, WHETHER OR NOT FORESEEABLE AND WHETHER OR NOT
APPLIED BIOSYSTEMS IS ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, INCLUDING WITHOUT LIMITATION, DAMAGES ARISING FROM
OR RELATED TO LOSS OF USE, LOSS OF DATA, FAILURE OR INTERRUPTION
IN THE OPERATION OF ANY EQUIPMENT OR SOFTWARE, DELAY IN REPAIR
OR REPLACEMENT, OR FOR LOSS OF REVENUE OR PROFITS, LOSS OF
GOOD WILL, LOSS OF BUSINESS, OR OTHER FINANCIAL LOSS OR
PERSONAL INJURY OR PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF APPLIED BIOSYSTEMS
HAS ANY AUTHORITY TO MODIFY THE TERMS OF THIS LIMITED
WARRANTY STATEMENT OR TO BIND APPLIED BIOSYSTEMS TO ANY
AFFIRMATION, REPRESENTATION, OR WARRANTY CONCERNING THE
PRODUCT THAT IS NOT CONTAINED IN THIS LIMITED WARRANTY
STATEMENT, AND ANY SUCH MODIFICATION, AFFIRMATION,
REPRESENTATION, OR WARRANTY MADE BY ANY AGENT, EMPLOYEE, OR
REPRESENTATIVE OF APPLIED BIOSYSTEMS WILL NOT BE BINDING ON
APPLIED BIOSYSTEMS, UNLESS IN A WRITING SIGNED BY AN EXECUTIVE
OFFICER OF APPLIED BIOSYSTEMS.
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Appendix H Instrument Warranty Information
Damages, claims, and returns

THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM
APPLIED BIOSYSTEMS AND IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion
of warranties, of liability, such as liability for gross negligence or willful misconduct,
or of remedies or damages, as or to the extent set forth above. In such countries and
jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages
set forth above shall apply to the fullest extent permitted by law, and shall not apply to
the extent prohibited by law.

Damages, claims, and returns

Damages If shipping damage to the product is discovered, contact the shipping carrier and
request inspection by a local agent. Secure a written report of the findings to support
any claim. Do not return damaged goods to Applied Biosystems without first securing
an inspection report and contacting Applied Biosystems Technical Support for a
Return Authorization (RA) number.

Claims  After a damage inspection report is received by Applied Biosystems, Applied
Biosystems will process the claim unless other instructions are provided.

Returns Do not return any material without prior notification and authorization.

If for any reason it becomes necessary to return material to Applied Biosystems,
contact Applied Biosystems Technical Support or your nearest Applied Biosystems
subsidiary or distributor for a return authorization (RA) number and forwarding
address. Place the RA number in a prominent location on the outside of the shipping
container, and return the material to the address designated by the Applied Biosystems
representative.
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This appendix is the Applied Biosystems End User Software License Agreement for
Instrument Operating and Associated Bundled Software and Limited Product
Warranty.

NOTICE TO USER: PLEASE READ THIS DOCUMENT CAREFULLY. THIS IS
THE CONTRACT BETWEEN YOU AND APPLIED BIOSYSTEMS, LLC,
REGARDING THE OPERATING SOFTWARE FOR YOUR APPLIED
BIOSYSTEMS WORKSTATION OR OTHER INSTRUMENT AND BUNDLED
SOFWARE INSTALLED WITH YOUR OPERATING SOFTWARE. THIS
AGREEMENT CONTAINS WARRANTY AND LIABILITY DISCLAIMERS AND
LIMITATIONS. YOUR INSTALLATION AND USE OF THE APPLIED
BIOSYSTEMS SOFTWARE IS SUBJECT TO THE TERMS AND CONDITIONS
CONTAINED IN THIS END USER SOFTWARE LICENSE AGREEMENT.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS
LICENSE, YOU SHOULD PROMPTLY RETURN THIS SOFTWARE, TOGETHER
WITH ALL PACKAGING, TO APPLIED BIOSYSTEMS AND YOUR PURCHASE
PRICE WILL BE REFUNDED

This Applied Biosystems End User License Agreement accompanies an Applied
Biosystems® software product (“Software”) and related explanatory materials
(“Documentation’). The term “Software” also includes any upgrades, modified
versions, updates, additions and copies of the Software licensed to you by Applied
Biosystems. The term “Applied Biosystems,” as used in this License, means Applied
Biosystems, LLC. The term “License” or “Agreement” means this End User Software
License Agreement. The term “you” or “Licensee” means the purchaser of this license
to use the Software.

Third party products

This Software uses third-party software components from several sources. Portions of
these software components are copyrighted and licensed by their respective owners.
Various components require distribution of source code or if a URL is used to point the
end-user to a source-code repository, and the source code is not available at such site,
the distributor must, for a time determined by the license, offer to provide the source
code. In such cases, please contact your Life Technologies representative. As well,
various licenses require that the end-user receive a copy of the license. Such licenses
may be found on the distribution media in a folder called “Licenses.” In order to use
this Software, the end-user must abide by the terms and conditions of these third-party
licenses. After installation, the licenses may also be found in a folder named
“Licenses” located in the Software installation's root directory.
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Title

Title

Title, ownership rights and intellectual property rights in and to the Software and
Documentation shall at all times remain with Applied Biosystems, LLC and its
subsidiaries, and their suppliers. All rights not specifically granted by this License,
including Federal and international copyrights, are reserved by Life Technologies or
their respective owners.

Copyright

The Software, including its structure, organization, code, user interface and associated
Documentation, is a proprietary product of Life Technologies or its suppliers, and is
protected by international laws of copyright. The law provides for civil and criminal
penalties for anyone in violation of the laws of copyright.

License

Use of the software 1. 1.Subject to the terms and conditions of this Agreement, Applied Biosystems,
LLC grants the purchaser of this product a non-exclusive license only to install
and use the Software to operate the single product in connection with which this
License was purchased and to display, analyze and otherwise manipulate data
generated by the use of such product. There is no limit to the number of computers
on which you may install and use the Software to display, analyze and otherwise
manipulate such data.

2. Ifthe Software uses registration codes, access to the number of licensed copies of
Software is controlled by a registration code. For example, if you have a
registration code that enables you to use five copies of Software simultaneously,
you cannot install the Software on more than five separate computers.

3. You may make one copy of the Software in machine-readable form solely for
backup or archival purposes. You must reproduce on any such copy all copyright
notices and any other proprietary legends found on the original. You may not
make any other copies of the Software except as permitted under Section 1 above.
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Restrictions 1. You agree that you will not copy, transfer, rent, modify, use or merge the Software,
or the associated documentation, in whole or in part, except as expressly permitted
in this Agreement.

2. You agree that you will not reverse assemble, decompile, or otherwise reverse
engineer the Software.

3. You agree that you will not remove any proprietary, copyright, trade secret or
warning legend from the Software or any Documentation.
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Trial

Termination

US government end

1562

users

European
community end
users

Regulated uses

4. You agree to fully comply with all export laws and restrictions and regulations of
the United States or applicable foreign agencies or authorities. You agree that you
will not export or reexport, directly or indirectly, the Software into any country
prohibited by the United States Export Administration Act and the regulations
thereunder or other applicable United States law.

5. You agree that you will not modify, sell, rent, transfer (except temporarily in the
event of a computer malfunction), resell for profit, or distribute this license or the
Software, or create derivative works based on the Software, or any part thereof or
any interest therein. Notwithstanding the foregoing, if this Software is instrument
operating software, you may transfer this Software to a purchaser of the specific
instrument in or for which this Software is installed in connection with any sale of
such instrument, provided that the transferee agrees to be bound by and to comply
with the provisions of this Agreement.

If this license is granted on a trial basis, you are hereby notified that license
management software may be included to automatically cause the Software to cease
functioning at the end of the trial period.

You may terminate this Agreement by discontinuing use of the Software, removing all
copies from your computers and storage media, and returning the Software and
Documentation, and all copies thereof, to Life Technologies. Life Technologies may
terminate this Agreement if you fail to comply with all of its terms, in which case you
agree to discontinue using the Software, remove all copies from your computers and
storage media, and return the Software and Documentation, and all copies thereof, to
Life Technologies.

The Software is a “commercial item,” as that term is defined in 48 C.F.R. 2.101 (Oct.
1995), consisting of “commercialcomputer software” and“commercial computer
software documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept. 1995).
Consistent with 48 C.FR. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June
1995), all U.S. Government End Users acquire the Software with only those rights set
forth herein.

If this Software is used within a country of the European Community, nothing in this
Agreement shall be construed as restricting any rights available under the European
Community Software Directive, O.J. Eur. Comm. (No. L. 122) 42 (1991).

You acknowledge that the Software has not been cleared, approved, registered or
otherwise qualified (collectively, “Approval”) by Applied Biosystems, LLC with any
regulatory agency for use in diagnostic or therapeutic procedures, or for any other use
requiring compliance with any federal or state law regulating diagnostic or therapeutic
products, blood products, medical devices or any similar product (hereafter collectively
referred to as “federal or state drug laws™). The Software may not be used for any
purpose that would require any such Approval unless proper Approval is obtained. You
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License

agree that if you elect to use the Software for a purpose that would subject you or the
Software to the jurisdiction of any federal or state drug laws, you will be solely
responsible for obtaining any required Approvals and otherwise ensuring that your use
of the Software complies with such laws.
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Limited warranty and limitation of remedies

Limited warranty and limitation of remedies

154

Limited Warranty. Applied Biosystems warrants that, during the same period as of
the SOLiD Analyzer for which this Software is an instrument operating software, the
Software will function substantially in accordance with the functions and features
described in the Documentation delivered with the Software when properly installed,
and that for a period of ninety days from the beginning of the applicable warranty
period (as described below) the tapes, CDs, diskettes or other media bearing the
Software will be free of defects in materials and workmanship under normal use.

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation outside of the environmental or use
specifications, or not in conformance with the instructions for any instrument system,
software, or accessories; improper or inadequate maintenance by the user; installation
of software or interfacing, or use in combination with software or products not supplied
or authorized by Applied Biosystems; intrusive activity, including without limitation
computer viruses, hackers or other unauthorized interactions with instrument or
software that detrimentally affects normal operations;.and modification or repair of the
products not authorized by Applied Biosystems.

Warranty Period Commencement Date. The applicable warranty period for software
begins on the earlier of the date of installation or three (3) months from the date of
shipment for software installed by Applied Biosystems' personnel. For software
installed by the purchaser or anyone other than Applied Biosystems, the warranty
period begins on the date the software is delivered to you. The applicable warranty
period for media begins on the date the media is delivered to the purchaser.

APPLIED BIOSYSTEMS MAKES NO OTHER WARRANTIES OF ANY KIND
WHATSOEVER, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE
OR DOCUMENTATION, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY OR THAT
THE SOFTWARE OR DOCUMENTATION IS NON-INFRINGING. ALL OTHER
WARRANTIES ARE EXPRESSLY DISCLAIMED. WITHOUT LIMITING THE
GENERALITY OF THE FOREGOING, APPLIED BIOSYSTEMS MAKES NO
WARRANTIES THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS,
THAT OPERATION OF THE LICENSED SOFTWARE WILL BE
UNINTERRUPTED OR ERROR FREE OR WILL CONFORM EXACTLY TO THE
DOCUMENTATION, OR THAT APPLIED BIOSYSTEMS WILL CORRECT ALL
PROGRAM ERRORS. APPLIED BIOSYSTEMS' SOLE LIABILITY AND
RESPONSIBILITY FOR BREACH OF WARRANTY RELATING TO THE
SOFTWARE OR DOCUMENTATION SHALL BE LIMITED, AT APPLIED
BIOSYSTEMS' SOLE OPTION, TO (1) CORRECTION OF ANY ERROR
IDENTIFIED TO APPLIED BIOSYSTEMS IN A WRITING FROM YOU IN A
SUBSEQUENT RELEASE OF THE SOFTWARE, WHICH SHALL BE SUPPLIED
TO YOU FREE OF CHARGE, (2) ACCEPTING A RETURN OF THE PRODUCT,
AND REFUNDING THE PURCHASE PRICE UPON RETURN OF THE PRODUCT
AND REMOVAL OF ALL COPIES OF THE SOFTWARE FROM YOUR
COMPUTERS AND STORAGE DEVICES, (3) REPLACEMENT OF THE
DEFECTIVE SOFTWARE WITH A FUNCTIONALLY EQUIVALENT PROGRAM
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Limitation of liability

AT NO CHARGE TO YOU, OR (4) PROVIDING A REASONABLE WORK
AROUND WITHIN A REASONABLE TIME. APPLIED BIOSYSTEMS SOLE
LIABILITY AND RESPONSIBILITY UNDER THIS AGREEMENT FOR BREACH
OF WARRANTY RELATING TO MEDIA IS THE REPLACEMENT OF
DEFECTIVE MEDIA RETURNED WITHIN 90 DAYS OF THE DELIVERY DATE.
THESE ARE YOUR SOLE AND EXCLUSIVE REMEDIES FOR ANY BREACH OF
WARRANTY. WARRANTY CLAIMS MUST BE MADE WITHIN THE
APPLICABLE WARRANTY PERIOD.

Limitation of liability

IN NO EVENT SHALL APPLIED BIOSYSTEMS OR ITS SUPPLIERS BE
RESPONSIBLE OR LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY
OR UNDER ANY STATUTE (INCLUDING WITHOUT LIMITATION ANY
TRADE PRACTICE, UNFAIR COMPETITION OR OTHER STATUTE OF
SIMILAR IMPORT) OR ON ANY OTHER BASIS FOR SPECIAL, INDIRECT,
INCIDENTAL, MULTIPLE, PUNITIVE, OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE POSSESSION OR USE OF, OR THE INABILITY TO USE,
THE SOFTWARE OR DOCUMENTATION, EVEN IF APPLIED BIOSYSTEMS IS
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES,
INCLUDING WITHOUT LIMITATION DAMAGES ARISING FROM OR
RELATED TO LOSS OF USE, LOSS OF DATA, DOWNTIME, OR FOR LOSS OF
REVENUE, PROFITS, GOODWILL OR BUSINESS OR OTHER FINANCIAL
LOSS. IN ANY CASE, THE ENTIRE LIABILITY OF APPLIED BIOSYSTEMS'
AND ITS SUPPLIERS UNDER THIS LICENSE, OR ARISING OUT OF THE USE
OF THE SOFTWARE, SHALL NOT EXCEED IN THE AGGREGATE THE
PURCHASE PRICE OF THE PRODUCT.

SOME STATES, COUNTRIES OR JURISDICTIONS LIMIT THE SCOPE OF OR
PRECLUDE LIMITATIONS OR EXCLUSION OF REMEDIES OR DAMAGES, OR
OF LIABILITY, SUCH AS LIABILITY FOR GROSS NEGLIGENCE OR WILLFUL
MISCONDUCT, AS OR TO THE EXTENT SET FORTH ABOVE, OR DO NOT
ALLOW IMPLIED WARRANTIES TO BE EXCLUDED. IN SUCH STATES,
COUNTRIES OR JURISDICTIONS, THE LIMITATION OR EXCLUSION OF
WARRANTIES, REMEDIES, DAMAGES OR LIABILITY SET FORTH ABOVE
MAY NOT APPLY TO YOU. HOWEVER, ALTHOUGH THEY SHALL NOT APPLY
TO THE EXTENT PROHIBITED BY LAW, THEY SHALL APPLY TO THE
FULLEST EXTENT PERMITTED BY LAW. YOU MAY ALSO HAVE OTHER
RIGHTS THAT VARY BY STATE, COUNTRY OR OTHER JURISDICTION.
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General

General

156

This Agreement shall be governed by laws of the State of California, exclusive of its
conflict of laws provisions. This Agreement shall not be governed by the United
Nations Convention on Contracts for the International Sale of Goods. This Agreement
contains the complete agreement between the parties with respect to the subject matter
hereof, and supersedes all prior or contemporaneous agreements or understandings,
whether oral or written. If any provision of this Agreement is held by a court of
competent jurisdiction to be contrary to law, that provision will be enforced to the
maximum extent permissible, and the remaining provisions of this Agreement will
remain in full force and effect. The controlling language of this Agreement, and any
proceedings relating to this Agreement, shall be English. You agree to bear any and all
costs of translation, if necessary. The headings to the sections of this Agreement are
used for convenience only and shall have no substantive meaning. All questions
concerning this Agreement shall be directed to: Applied Biosystems, 850 Lincoln
Centre Drive, Foster City, CA 94404-1128, Attention: Legal Department.

Unpublished rights reserved under the copyright laws of the United States.
Applied Biosystems, LLC, 850 Lincoln Centre Drive, Foster City, CA 94404.

Applied Biosystems is a registered trademark of Life Technologies or its subsidiaries in
the U.S. and/or certain other countries.

All other trademarks are the sole property of their respective owners.
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Symbols on instruments

Electrical The following table describes the electrical symbols that may be displayed on

symbols on  Applied Biosystems instruments.
instruments

Symbol Description

I Indicates the On position of the main power switch.

O Indicates the Off position of the main power switch.

Indicates a standby switch by which the instrument is switched on to the
Standby condition. Hazardous voltage may be present if this switch is on
standby.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of
another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or
>~ voltage.

Safety symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Safety labels on instruments” on page 160). These
safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS
that occur in the text of this and other product-support documents.

Symbol Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard
and to proceed with appropriate caution.

B> [>
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Description

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

Indicates the presence of a biological hazard and to proceed with
appropriate caution.

Indicates the presence of a radiological hazard and to proceed with
appropriate caution.

Indicates the presence of a slipping hazard and to proceed with appropriate
caution.

BB P

Indicates the presence of an ultraviolet light (in the instrument?) and to
proceed with appropriate caution.

Environmental The following symbol applies to all Applied Biosystems electrical and electronic
symbols on  products placed on the European market after August 13, 2005.

instruments

Symbol

Description

J

i

X
-

Do not dispose of this product as unsorted municipal waste. Follow
local municipal waste ordinances for proper disposal provisions to reduce
the environmental impact of waste electrical and electronic equipment

(WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment
pick-up and recycling. See www.appliedbiosystems.com for a list of
customer service offices in the European Union.
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Safety labels on instruments

The SOLiD™ 3 System contains warnings at the locations listed in Table 25.
Table 25 Where to find safety labels on the SOLID™ 3 System

Safety label Located by...
CAUTION! Hot Surfaces. Flow cell cover and inside arc lamp box
CAUTION! Replace only with CERMAX Arc lamp box cover

[x300f, 300 W Lamp

WARNING! HOT! Do not remove lamp until Arc lamp box cover
15 minutes after disconnecting
supply!Surfaces.

CAUTION! Crush/Pinch hazard Syringe pump
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General instrument safety

Moving and lifting
the instrument

Moving and lifting
stand-alone
computers and
monitors

Operating the
instrument

Cleaning or
decontaminating
the instrument

SOLID™ 3 System Instrument Operation Guide

ﬁ WARNING! PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

CAUTION! PHYSICAL INJURY HAZARD. The instrument is to be moved
and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been
installed, do not attempt to lift or move the instrument without the assistance of
others, the use of appropriate moving equipment, and proper lifting techniques.
Improper lifting can cause painful and permanent back injury. Depending on the
weight, moving or lifting an instrument may require two or more persons.

é WARNING! Do not attempt to lift or move the computer or the monitor without

the assistance of others. Depending on the weight of the computer and/or the
monitor, moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

Make sure that you have a secure, comfortable grip on the computer or the
monitor when lifting.

Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

Do not lift an object and twist your torso at the same time.
Keep your spine in a good neutral position while lifting with your legs.

Participants should coordinate lift and move intentions with each other before
lifting and carrying.

Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:

Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page 167.

CAUTION! Before using a cleaning or decontamination method other than
those recommended by the manufacturer, verify with the manufacturer that the
proposed method will not damage the equipment.
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Physical hazard safety

Ultraviolet light WARNING! ULTRAVIOLET LIGHT HAZARD. Looking directly at a UV
light source can cause serious eye damage. Never look directly at a UV light
source and always prevent others from UV exposure. Follow the manufacturer’s
recommendations for appropriate protective eyewear and clothing.

Moving parts ii WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and
cut. Keep hands clear of moving parts while operating the instrument.
Disconnect power before servicing the instrument.

Solvents and WARNING! PHYSICAL INJURY HAZARD. Always wear eye protection
pressurized fluids when working with solvents or any pressurized fluids.

* Be aware that polymeric tubing is a polymeric material. Use caution when
working with any polymer tubing that is under pressure.

Always wear eye protection when near pressurized polymer tubing.
» Extinguish all nearby flames if you use flammable solvents.
» Do not use polymeric tubing that has been severely stressed or kinked.
* Do not use polymeric tubing with tetrahydrofuran or nitric and sulfuric acids.

* Be aware that methylene chloride and dimethyl sulfoxide cause polymeric tubing
to swell and greatly reduce the rupture pressure of the tubing.

* Be aware that high solvent flow rates (~40 mL/min) may cause a static charge to
build up on the surface of the tubing. Electrical sparks may result.
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Electrical safety

A WARNING! ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the SOLiD™ 3 System without its instrument panels in
place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

Fuses & WARNING! FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the
instrument, verify that the fuses are properly installed and that the instrument
voltage matches the power supply in your laboratory.

ii WARNING! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

Power A WARNING! ELECTRICAL HAZARD. Grounding circuit continuity is
required for the safe operation of equipment. Never operate equipment with the
grounding conductor disconnected.

WARNING! ELECTRICAL HAZARD. Use properly configured and
approved line cords for the voltage supply in your facility.

WARNING! ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage rating The SOLiD"™ 3 System has an installation (overvoltage) category of II, and is classified
as portable equipment.

SOLID™ 3 System Instrument Operation Guide 163



J Appendix J Safety
Instrumentation safety

Workstation safety

Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION
HAZARD. These hazards are caused by potential risk factors that include but
are not limited to repetitive motion, awkward posture, forceful exertion, holding
static unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:

* Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and electromagnetic compatibility (EMC) standards

U.S. and Canadian
safety
standards

c(UL)us

Canadian EMC
standard

European safety
and EMC
standards

C€

Australian EMC
Standards

C
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This section provides information on:

+ U.S. and Canadian safety standards
* Canadian EMC standard

» European safety and EMC standards
* Australian EMC Standards

The SOLiD™ 3 System has been tested to and complies with standard:

UL 61010-1/CSA C22.2 No. 61010-1, “Safety Requirements for Electrical Equipment
for Measurement, Control, and Laboratory Use, Part 1: General Requirements.”

UL 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating
of Materials.”

This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Scientific, and Medical Radio Frequency Generators.”

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards

EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement,
Control and Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating
of Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of
Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chemical safety

General chemical safety

166

Chemical hazard
warning

WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to
the Material Safety Data Sheet (MSDS) provided by the manufacturer, and
observe all relevant precautions.

ﬁ WARNING! CHEMICAL HAZARD. All chemicals in the instrument,

including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

ﬁ WARNING! CHEMICAL HAZARD. Four-liter reagent and waste bottles can

crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in
the upright position. Wear appropriate eyewear, clothing, and gloves when
handling reagent and waste bottles.

é WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page 167.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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MSDSs

About MSDSs  Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with
the first shipment of a hazardous chemical to a customer after an MSDS has been
updated. MSDSs provide the safety information you need to store, handle, transport,
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free
MSDSs 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then select MSDS.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

*  Open — To view the document
* Print Target — To print the document

* Save Target As — To download a PDF version of the document to a
destination that you choose

\g Note: For the MSDSs of chemicals not distributed by Applied Biosystems,
contact the chemical manufacturer.
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Chemical safety

Chemical waste safety

Chemical waste
hazards

Chemical waste
safety guidelines

Waste disposal
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CAUTION! HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
local regulations for handling and disposal.

ﬁ WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste
in a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

To minimize the hazards of chemical waste:

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste material
and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and
health regulations.

If potentially hazardous waste is generated when you operate the instrument, you must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.
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Chemical safety
* Ensure that the instrument waste is stored, transferred, transported, and disposed

of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

General biohazard WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes but
is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves.
All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

» U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-
040-00547-4; bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov
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Safety alerts

Safety alerts
For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words” on page vii.

Chemical alerts

General alerts for  Causes eye, skin, and respiratory tract irritation. Avoid breathing vapor. Use with
all chemicals  adequate ventilation. Avoid contact with eyes and skin. Read the MSDS, and follow the
handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

Specific DANGER! CHEMICAL HAZARD. 2-Butanol is a flammable liquid and
chemical alerts vapor. Causes eye, skin, and respiratory tract irritation. Harmful if inhaled. Keep
away from heat, sparks and flame. Avoid breathing vapor. Do not get in eyes or
on skin. Use only with adequate ventilation. Avoid contact with eyes, skin and
clothing.

A WARNING! CHEMICAL HAZARD. Cleave Solution 1. Wastes produced
by Applied Biosystems instruments are potentially hazardous and can cause
injury, illness, or death. Instrument waste when spilled should be cleaned
up immediately to prevent slipping injuries. Instrument waste can be
classified as Hazard Class 9 (silver and mercaptans) with an US EPA Code:
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D011 (silver). However, at the relatively low mg/L concentrations found in
this waste stream, shipments of lab-quantity volumes would be well below
the RQ — meaning that “RQ” would not need to be included in the DOT
description on the hazardous waste shipping manifest.

WARNING! CHEMICAL HAZARD. Cleave Solution 2.

WARNING! CHEMICAL HAZARD. Deposition Buffer.

> (B (B

CAUTION! CHEMICAL HAZARD. Glycerol may cause eye, skin, and
respiratory tract irritation. May be harmful if swallowed.

WARNING! CHEMICAL HAZARD. 10X Instrument Buffer.

WARNING! CHEMICAL HAZARD. Reset Buffer is harmful if inhaled,
swallowed, or absorbed through skin. It causes eye, skin, and respiratory tract
irritation.

> (B

WARNING! CHEMICAL HAZARD. Sodium Acetate Solution.

WARNING! CHEMICAL HAZARD. 20X SSPE Solution.

WARNING! CHEMICAL HAZARD. Storage Buffer.

SEE
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barcode

barcoded fragment
library

BC tag
bead count
bead signal

best beads

F3 tag

fragment library

good beads

image signal

internal adaptor

library

mappable beads

mate-paired library

multiplexing
N2S plot

on-axis beads

optimal titration
point

Glossary

Unique sequence identifier added to the sample during library construction

Fragment library with a barcode sequence appended to the 3" end of the sheared DNA
fragments

Barcode tag
The number of beads detected in a panel
The average signal intensity of every pixel associated with a bead

Number of beads that meet a stringent set of criteria based on spectral purity and
intensity

Tag to be sequenced using primers specific to the P1 Adaptor sequence

Library consisting of a sheared DNA fragment with P1 and P2 Adaptors ligated to the
5" end and 3’ end respectively

The number of beads that meet criteria (less stringent than best beads criteria) based on
spectral purity and intensity

The average signal intensity of every pixel whether or not it is associated with a bead or
not

Double-stranded oligonucleotide located between two tags to be sequenced

Set of DNA tags prepared from the same biological sample to be sequenced on the
SOLiD™ System

Beads with template that map back to the reference genome

Library consisting of two DNA tags a known distance apart linked by an internal
adaptor with P1 and P2 Adaptors ligated to the 5" end and 3’ end, respectively

Method to analyze multiple biological samples in a single spot using barcodes
Plot indicating noise-to-signal for each dye

The frequency of template-positive beads that meet a defined threshold of spectral
purity and signal intensity after a single ligation step

Library template concentration that gives the best sequencing results
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Glossary

P1 Adaptor
P2 Adaptor

P2#/P1# ratio

P2-positive beads

pulse-spin

R3 tag

remove the
supernatant

resuspend the
beads

Satay plot

sonicate the beads

tag

templated bead
preparation

templated beads
titration

titration metric

usable beads

workflow analysis
(WFA) run

174

Double-stranded oligonucleotide ligated at the 5" end of the library
Double-stranded oligonucleotide ligated at the 3 end of the library

The frequency of template-positive beads (P2#) relative to total beads (P1#) deposited
on the slide; this metric is also referred to as “% P2 Positive” value

SOLiD™ P1 DNA beads with fully extended and amplified template

Place the tube in a picofuge and spin for a few seconds to bring down any beads or
liquid stuck on the walls of the tube

Tag to be sequenced using primers specific to the Internal Adaptor sequence

Use a pipette to carefully remove the liquid from the tube without disturbing any beads

The beads can be resuspended in one of two ways:

* Gently pipette the solution up and down until the beads are suspended. Using a
slower speed to aspirate and expel the solution minimizes the amount of beads that
stick to the inside of the pipette tip.

* Vortex the solution until all of the beads are suspended. Place the beads in a
picofuge and pulse-spin for a few seconds to bring down any beads stuck on the
walls of the tube. Do not over-spin the beads or the beads aggregate into a pellet.

Indicator of spectral purity and signal intensity of the beads

Place the tube containing the beads in the appropriate tube holder, then place in the
Covaris™ S2 System; afterwards, run the appropriate program

A length of DNA to be sequenced

Process of adding library template to beads by emulsion PCR, enriching the beads to
remove beads without template, then modifying the 3" end of the template on the beads
to prepare for bead deposition and sequencing

SOLiD™ P1 DNA Beads with amplified library template attached

Library template concentration used to prepare an emulsion

Product of % P2 positive beads and the On-Axis beads; the titration that generates the
highest titration metric value is the optimal titration point for a given library

Number of beads that are called during color-calling

Type of run on the SOLiD™ system in which a small portion of templated beads are
deposited and analyzed to test for templated bead quality
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Related documentation

Documentation

Part .

Document number Description
Applied Biosystems 4407413 Describes how to prepare fragment and mate-
SOLiD™ 3 System Library paired libraries for templated bead preparation
Preparation Guide and sequencing on the SOLID™ 3 System.
Applied Biosystems 4407414 Provides brief, step-by-step procedures for
SOLiD™ 3 System Library preparing libraries.
Preparation Quick
Reference Card
Applied Biosystems 4407421 Describes how to prepare templated beads by
SOLID™ 3 System emulsion PCR (ePCR), required before
Templated Bead sequencing on the SOLID™ 3 System.
Preparation Guide
Applied Biosystems 4407429 Provides brief, step-by-step procedures for
SOLID™ 3 System preparing templated beads by emulsion PCR
Templated Bead (ePCR), required before sequencing on the
Preparation Quick SOLID™ 3 System.
Reference Card
Applied Biosystems 4407431 Provides brief, step-by-step procedures for
SOLiD™ 3 System loading and running the SOLID™ 3 System.
Instrument Operation
Quick Reference Card
SOLID™ 3 System Site 4386998 Provides all the information that you need to set
Preparation Guide up the SOLID™ 3 System.
Applied Biosystems 4389302 Describes how to monitor the run, modify run
SOLiD™ 3 System SETS settings, and/or perform data analysis for the
Software Getting Started SOLiD™ 3 System.
Guide
Applied Biosystems — Provides convenient information for setting up a
SOLiD™ 3 System run on the SOLID™ 3 System (see the Instrument
Instrument Control Control Software).
Software (ICS) Help
SOLID™ Analysis Tools 4392959 Provides in-depth information on sequencing

(SAT) User Guide

analysis with the SOLID™ 3 System.

E Note: For additional documentation, see “How to obtain support” on page ix.
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Documentation
Send us your comments

Send us your comments

Applied Biosystems welcomes your comments and suggestions for improving its user
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is for submitting comments and
suggestions relating only to documentation. To order documents, download PDF

files, or for help with a technical question, see “How to obtain support” on
page ix.
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Information Development department 176

B

biohazardous waste, handling 170
bold text, when to use ix

C

CAUTION, description vii

checklists and workflow tracking forms 133
chemical safety 166

chemical waste safety 168

clean the reagent strip cover 103

clean the SOLiD™ Deposition Chamber using a
sonicator 98

clean the SOLiD™ Deposition Chamber using Extran
300 100

conventions
bold text ix
for describing menu commands ix
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in this guide ix
italic text ix
Notes ix
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Covaris ™ S2 System 139
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DANGER, description vii
documentation 175
documentation, related 175

E

electrical safety 163

electromagnetic compatibility standards. See EMC
standards

EMC standards 165
end user software license agreement 149
ergonomics, safety 164
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guidelines
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hazard icons. See safety symbols, on instruments 158
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Information Development department, contacting 176
install the SOLiD™ Flowcell O-Ring 102
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instrument operation, safety 161

instrument process times 129
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M

manually find the focus range 107
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prepare and install slides and reagents 11 replace the SOLiD™ Light Source 104
pressurized fluids, safety 162 reset the robot position 119

set up a run by importing a Run Definition file 106
R shut down the SOLiD™ 3 Analyzer 119

store the slide in a flowcell 119

radioactive waste, handling 169 symbols, safety 158

repetitive motion, safety 164
replace the SOLiD™ Light Source 104 T
required materials 85

reset the robot position 119

S

text conventions ix
training, information on ix

U

safety 157 ' '
before operating the instrument 161 ultraviolet light, safety 162
biological hazards 170 user attention words, described ix
chemical 166
chemical waste 168 w

electrical 163
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guidelines 166, 168
instrument operation 161
moving and lifting computers and monitors 161
moving and lifting instrument 161
moving parts 162
physical hazard 162
pressurized fluids. See also compressed gases, safety
repetitive motion 164
solvents 162
standards 165
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workstation 164
safety labels, on instruments viii, 160
safety standards 165
safety symbols, on instruments 158
set up a run by importing a Run Definition file 106
set up, control, and monitor the run 41
shut down the SOLiD™ 3 Analyzer 119
software license agreement 149
SOLID™ 3 Analyzer plumbing system schematic 131
solvents, safety 162
standards
EMC 165
safety 165
store the slide in a flowcell 119
supplemental procedures
clean the reagent strip cover 103
clean the SOLiD™ Deposition Chamber using a
sonicator 98
clean the SOLiD™ Deposition Chamber using Extran
300 100
install the SOLiD™ Flowcell O-Ring 102

manually find the focus range 107

WARNING, description vii
waste disposal, guidelines 168
waste profiles, description 168
workstation safety 164
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